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Introduction
This Job Aid provides workers with the information they need to use the Permanency Hearing
Reports functionality implemented in CONNECTIONS as part of Build 18.9 effectively as part of
their casework responsibilities. It is intended for all workers and provides a detailed overview of
the Permanency Hearing Reports in CONNECTIONS.
Specifically, this Job Aid contains information about:
•

the major changes introduced with the Permanency Bill (Chapter 3 of the Laws of 2005);

•

the three types of Permanency Hearing Reports;

•

who can launch, view and modify the reports;

•

the pre-fill option for reports;

•

from where in CONNECTIONS Permanency Hearing Report content is generated;

•

launching a Permanency Hearing Report;

•

modifying a Permanency Hearing Report;

•

printing a Permanency Hearing Report;

•

emailing a Permanency Hearing Report;

•

deleting a “Draft” Permanency Hearing Report;

•

the Permanency Hearing Notices and Statement;

•

who must receive notice of the permanency hearing and report;

•

recording court information; and

•

printing the Notices and Statement.

Any visible identifying data in this Job Aid is
simulated and has not been taken from the
Production Database. When Build 18.9 is
implemented, the windows may appear different
than illustrated in this Job Aid.
This Job Aid assumes familiarity with the
CONNECTIONS system.

This Job Aid is available on the CONNECTIONS intranet site:
OCFS intranet home page > CONNECTIONS > Step-by-Step/Job Aids/Tips
The OCFS CONNECTIONS intranet site also contains information about trainings offered to support
you in your work with CONNECTIONS.

CONNECTIONS System Build 18.9 Job Aid: Permanency Hearing Reports v1.0 (03/06/2007)

Page 5

The 2005 Permanency Bill
The Permanency Bill (Chapter 3 of the Laws of 2005) is state legislation that took effect on
December 21, 2005, initiating the requirement of workers to create and file Permanency Hearing
Reports with the court and to send these reports to a number of other parties. These reports
serve as the means to notify the court and other required parties of a family’s progress. A
primary goal of the Permanency Hearing Report is that it provide the court with the most current
information possible. The Permanency Hearing Report must be mailed with the Permanency
Hearing Notice to required parties no later than 14 days prior to the Date Certain; it also must be
filed with the court. Three offline templates posted on the OCFS Permanency Bill website have
been in use for the completion of these reports; however, with the implementation of Build 18.9,
the templates will be incorporated directly into CONNECTIONS.

Major Implications of the Permanency Bill
On August 23, 2005, the Permanency Bill, Chapter 3 of the
Laws of 2005, was signed by the Governor, effective December
21, 2005. In order to support the new permanency legislation,
changes were made to the CONNECTIONS system. These
changes were implemented as part of Build 18.7 in December,
2005.
Children affected by the provisions of Part A of the Bill include:

For more information on the
Permanency Bill, refer to the
following site:
http://www.ocfs.state.ny.us/main
/legal/legislation/permanency

•

children who have entered foster care as abused or
neglected child (Article 10 of the Family Court Act)

•

children who have entered foster care through a voluntary placement agreement (§384-a
of the Social Services Law);

•

children in foster care who have been surrendered for adoption (§383-c of the Social
Services Law);

•

children who have been surrendered for adoption (§384-a of the Social Services Law);

•

foster children who a court has determined are completely legally free for adoption,
whether in foster care pursuant to Family Court Act Articles 3 (Juvenile Delinquent), 7
(PINS), or 10 (abused/neglected), or by voluntary placement or surrender; and

•

children placed by the court directly with a relative or other suitable person as an
outcome of a Family Court Article 10 matter.

In addition, OCFS recommends that children subject to Section 651.b of the Family Court Act
(Unaccompanied Refugee Minors), while not affected by the provisions of Part A, be treated the
same as those mentioned above.
Note: While the 2005 Permanency Bill does not expressly refer to Unaccompanied Refugee
Minors, OCFS’ position is that the standards of Article 10-A relating to permanency hearings
apply to such children in part in order to satisfy federal Title IV-E State Plan requirements
whereby New York must afford procedural safeguards to all categories of foster children,
irrespective of whether they receive Title IV-E funding or not.
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The main provisions of Part A of the bill include the following:
•

Courts are to set a “Date Certain” for each
permanency hearing for all children referenced above.
This date for the first permanency hearing is to be set
at the removal hearing (or the hearing approving the
Voluntary Placement Agreement or surrender).

You must record
the Date Certain in CCRS
Legal Activities.

•

The first permanency hearing for a child not completely freed for adoption must occur
no later than the date of removal from the home plus 60 days plus six (6) months
(must be no later than eight (8) months.

•

The first permanency hearing for a child completely freed for adoption must occur no
later than 30 days after the hearing that completely freed the child, but preferably
immediately following an approval of a Voluntary Surrender or a Termination of
Parental Rights disposition that completely frees a child for adoption.

•

Subsequent permanency hearings for completely
freed and non-freed children must be held at least
every six (6) months thereafter, for as long as the child
remains in foster care or in Non-LDSS Custody. A
Date Certain for the next hearing will be set at each
hearing, so that all parties know when they are
expected back in court. The Judge may set the next
permanency hearing at a date earlier than six (6)
months from the date of the current hearing, but not
later. In addition, all permanency hearings must be
completed within 30 days of commencement.

•

The twelve-month permanency
hearing cycle for children
subject to Article 3 (JD) and
Article 7 (PINS) proceedings
remains unchanged, unless they
are completely legally freed
for adoption.

Section 409-e of Social Services Law, as amended by
Chapter 3 of the Laws of 2005, specifies timeframes for assessment, case planning
and Service Plan Reviews based on the date of the physical removal of the child.
There must be a Service Plan Review within 60 to 90 days from the date of the child’s
removal.

With Build 18.7, the Removal Information tab was added to the Tracked Children Detail
window; this tab displays the Date Certain, which is first recorded in the Child Care Review
Service (CCRS) and brought forward into CONNECTIONS through an interface. The Removal
Information tab was also added to support the recording of removal information, including the
date of a child’s physical removal.
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Permanency Hearing Reports in CONNECTIONS
The implementation of Build 18.9 will allow you to more easily complete Permanency Hearing
Reports through the use of new CONNECTIONS functionality, which will enable you to
complete the templates directly in CONNECTIONS; the questions within the reports have not
changed. When launching a report, you will have the option for
information to pre-fill the report from the last approved FASP or
Plan Amendment, and the Health Services and Education
components. Only the demographic information, which does not
pre-fill from those areas, is not modifiable; FASP, Health
Use of the Permanency Hearing
Services, and Education information is modifiable.
Report, Notices and Statement
functionality in CONNECTIONS

Also with Build 18.9, CONNECTIONS will generate all
is not optional; you are required
Permanency Hearing Notices, as well as the Permanency
to use CONNECTIONS for the
Hearing Statement. Permanency Hearing Notices are used to
completion of these documents,
invite all required people (both in the FSS stage and not in the
since CONNECTIONS will
stage) to the Permanency Hearing (see page 24 for a list of the
maintain a comprehensive
record of them for each child.
individuals to whom a Notice must be sent). In CONNECTIONS,
you will select who to invite to the Permanency Hearing and
complete court information, after which CONNECTIONS will compile a list of the invitees. This
list pre-fills the Permanency Hearing Statement, which you must file with the court along with
the Permanency Hearing Report.
In addition to the ability to generate Permanency Hearing Reports, Notices and Statements,
CONNECTIONS will maintain a history of all completed Permanency Hearing Reports for each
child, as well as the Permanency Hearing Notices and Statement associated with each report.
Like the FASP, a Permanency Hearing Report is “launched” in CONNECTIONS. After it is
launched, the report will display in template form in a Word-like window, with a text control tool
for modifying the report. Once complete, you will be able to print the Permanency Hearing
Report, Notices and Statement to submit to necessary parties (e.g., Family Court, attorneys,
foster parents) or email them for review prior to printing and send them out.

Permanency Hearing Report Types
You will be able to generate Permanency Hearing Reports in CONNECTIONS for an individual
child or multiple children in the same case who are not completely legally freed for adoption, or
for an individual child who is completely legally freed for adoption; however, a child may be
involved in only one Permanency Hearing Report at a time. All three types of Permanency
Hearing Reports are available in CONNECTIONS.
Any worker with a role in the Family Services Stage can launch, view, modify, email and/or print
Permanency Hearing Reports. Both the Individual Child and Multiple Child reports can be
launched for children in FSS/CWS stages by any worker with a role in the stage; however, the
Freed Child report can only be launched for children in FSS/CCR stages by any worker with a
role in the stage.
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The Permanency Window
The Permanency window is the location in CONNECTIONS from where you can generate, view,
modify, email and/or print Permanency Hearing Reports. This window is accessed from the
Family Services Stage window by clicking on the Permanency tab (formerly the Key Dates
tab), which is always enabled.
Step-by-Step:
Accessing the Permanency Window
1

Click on the WORK button on the CONNECTIONS Toolbar.
The Assigned Workload displays.

2

Select the FSS stage and click on the Tasks… button.
The Family Services Stage window displays.

3

Click on the Permanency tab.
The Permanency window displays.

The Permanency window is comprised of a header, footer, Child List grid, Permanency Report
Summary grid and various buttons. The header contains the Stage Name, Stage ID, Case ID,
Case Name and Case Initiation Date, as well as File, Options and Help menus. The footer
contains the Close button, which is always enabled.
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The Child List Grid
The Child List grid section contains Active < 21, All Active and All radio buttons, a Pre-fill
field, a Launch button and the following fields, which are not modifiable (on this window):
Name

The child’s name.

Sex

The sex of the child.

Person ID

The child’s unique, system-generated identification number.

Age

The child’s age, as calculated using the system date and the
child’s date of birth.

DOB

The child’s date of birth.

Hearing Date Certain

The date of the next permanency hearing. This date is
populated from the Removal Information tab for the child(ren)
selected in the Child List grid; it is subsequently updated from
the Permanency Hearing Notices and Statements window if the
hearing date changes.

Program Choice 1

The child’s Program Choice.

Program Choice 2

The child’s second Program Choice, if applicable.

Program Choice 3

The child’s third Program Choice, if applicable.

Upon entering the window, the default display of the Child List is “Active<21,” meaning only
active children in the stage who are under 21 years of age will display in the grid, and the first
row in the grid is selected. Selecting the All Active radio button populates the grid with all active
individuals in the stage, while selecting the All radio button populates the grid with all active and
end-dated individuals in the stage. When the All or All Active radio button is selected, you can
select a person from the grid, but cannot launch or delete a report.
Individuals are listed in descending order by age, oldest to youngest; however, the sort order
can be changed by clicking on a column heading (e.g., Name, DOB).

The Launch Button
You can select one child from the grid—for an Individual Child or Freed Child report—or you can
select multiple children from the grid—for a Multiple Child report. Doing so enables the Launch
button and field above when the Active<21 radio button is selected; however, the child(ren)
selected in the grid must have a PPG or a Program Choice of “Placement” or “Non-LDSS
Custody” in order for the Launch button and field above to enable.
The field above the Launch button allows you to choose whether you want information to pre-fill
the Permanency Hearing Report. “Pre-fill” is the default; however, you can use the drop-down
arrow to select “No Pre-fill.” See page 15 for more information on the pre-fill option.
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The Permanency Report Summary Grid
Selecting a child or multiple children in the Child List grid will also populate the Permanency
Report Summary grid with any previously recorded Permanency Hearing Report information for
the child(ren). The reports are listed in descending order by date, with the most recent report
listed first; this report is automatically selected in the grid. Once a Permanency Hearing Report
has been generated and saved to the system, it is available for selection as a row in the grid.
The Permanency Report Summary grid contains the following fields:
Type

The type of Permanency Hearing Report (i.e., Individual, Multiple
or Freed).

Status

The status of the report (i.e., Draft or Final). A Permanency
Hearing Report will remain in “Draft” status until the report is
marked “Final” by clicking on the Final checkbox on the
Permanency Hearing Report window and saving (see page 21 for
more information on marking a report as “Final”).

Status Date

For “Draft” reports, the date the report was launched.
For “Final” reports, the date the report was marked “Final” by
clicking on the Final checkbox on the Permanency Hearing
Report window and saving.

Date Last Update

The date the permanency information was last saved on the
Permanency Hearing Report window. (See page 19 for more
information on this window.)

Hearing Date Certain

The date of the next permanency hearing. This date is originally
entered in CCRS and brought into CONNECTIONS through an
interface. It can be updated on the Court Information window if the
hearing date changes.

Report ID

The report’s unique system-generated identification number.

Several buttons display below the Permanency Report Summary grid:
Detail

Clicking on this button (or selecting the Detail command from the
Options menu) opens the selected Permanency Hearing Report.
This button enables when you select a row from the Permanency
Report Summary grid.

Notices and
Statement

Clicking on this button (or selecting the Notices and Statement
command from the Options menu) opens the Permanency
Hearing Notices and Statement window for the selected report.
This button enables when you select a row from the Permanency
Report Summary grid. (See page 24 for information on the
Permanency Hearing Notices and Statement.)

Delete

Clicking on this button (or selecting the Delete command from the
Options menu) deletes the selected “Draft” Permanency Hearing
Report. This button enables only when you select a “Draft”
Permanency Hearing Report from the grid. (See page 23 for
information on deleting a “Draft” Permanency Hearing Report.)
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Step-by-Step:
Accessing a Permanency Hearing Report from the Permanency Report
Summary Grid
1

Select the appropriate child(ren) from the Child List grid.
The Permanency Hearing Report information for the
child(ren) populates the grid.

2

Select the Permanency Hearing Report from the grid
by clicking on the box to the left of it.
The Detail and Notices and Statement buttons
enable (see page 24 for information on the Notices
and Statement). If the report is in “Draft” status, the
Delete button also enables (see page 23 for
information on deleting a Permanency Hearing
Report).

3

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab

Click on the Detail button.
The Permanency Hearing Report displays in the Permanency Hearing Report
window. If you accessed a “Draft” report, it is modifiable in this window; if you
accessed a “Final” report, it is not modifiable.

Mail Local Copy
Selecting a row in the Permanency Report Summary grid
enables the Mail Local Copy command in the Options menu
(on the Permanency window). This command allows you to
email a copy of the Permanency Hearing Report to the loggedon worker. Mailing a report will enable you to store it so that it
can be sent to required reviewers (e.g., supervisor, attorney). A
report may be emailed multiple times.
Although the Permanency Hearing Report and Statement may
be emailed to the court prior to the Date Certain, an original
sworn copy must also be filed with the court prior to the Date
Certain.
Upon clicking on the Mail Local Copy command, the following
message will display:
“The report will be mailed to <logged on user’s NT
ID>@nysemail.state.ny.us. If you cannot access this mailbox,
contact the Case Manager. Do you wish to proceed with the
mailing?”
Click on the No button to cancel the process; the email/report is
not sent.
Click on the Yes button to send the email with an attached copy
of the Permanency Hearing Report.

ACS workers and contract
agency workers (servicing an
ACS case) must use this
process to upload Permanency
Hearing Reports to LTS (Legal
Tracking System). Once you
have a copy of the report on
your desktop (after using the
Mail Local Copy function), use
the same steps currently in
place to upload the report to
LTS.
Voluntary agency workers
should submit the “Draft”
version of the Permanency
Hearing Report to LTS. That
way, if an ACS attorney would
like corrections made, the
voluntary agency worker can
make them.

For an Individual or Freed Child report, the subject of the email will be:
“Single S-<Stage ID> <Last Name> <First Name> R-<Report ID>”
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For a Multiple Child report, the subject of the email will be:
“Multiple S-<Stage ID> Multiple R-<Report ID>”
The body of the email contains a confidentiality disclaimer and
the Permanency Hearing Report is attached.
If the email server is unavailable or the email is otherwise not
able to be sent, the following message will display:
“Mail cannot be sent at this time. Please try again later.”
Click on the OK button to close the message.
If an email is undeliverable because the address is invalid, a
message will be sent to the return address mailbox (at OCFS).

ACS workers and contract
agency workers (servicing an
ACS case) may never email a
report to the court; reports must
go through the LTS attorney in
accordance with established
ACS procedures. In addition,
the attorney and Case Manager
should only get a copy of the
report through LTS using the
process already in place.

Step-by-Step:
Emailing a Permanency Hearing Report
1

Select the desired Permanency Hearing Report from
the Permanency Report Summary grid.

2

Click on the Options menu and select the Mail
Local Copy command.
A copy of the report is emailed to the logged-on
worker.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab

The security guidelines for
emailing must be followed.
Complete the following steps to
access the guidelines:
1. Navigate to the
CONNECTIONS intranet site.
2. Click on the Security link.
3. Access “Guidelines for using
Electronic Communication for
Sharing Case Specific
Information.”
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Once a report has been emailed to the logged-on worker, that worker must open it and apply
password protection before it can be forwarded to anyone. This requirement is crucial to avoid
revealing confidential material to unauthorized individuals, should the report/email be
misdirected by being sent to the wrong email address(es).
Step-by-Step:
Adding Password Protection to a Permanency Hearing Report
1

Navigate to your email and locate the system-generated email with the attached
Permanency Hearing Report.

2

Open the report by double-clicking on it.
The report displays in Microsoft Word.

3

Click on the File menu and select Save As.
The Save As dialog box displays.

4

Enter a file name in the File name field and select the desired location to save the
report to (e.g., drive, folder) in the Save in field.

5

Click on the Save button.

6

With the report still open, click on Tools and select Options.
The Options window displays.

7

Click on the Security tab.

8

Enter a password to open the report and/or a
password to modify the report. You can also check
the Read-only recommended checkbox, which will
prompt the person opening the report to do so in
read-only mode.

9

Click on the OK button.
If you entered a password to open and/or modify the
report, the Confirm Password window displays.

Passwords must never be sent
in the same email as the
Permanency Hearing Report;
Call the e-mail recipient and
give them the password. If the
recipient cannot be reached by
phone, the password may be
sent in a separate e-mail.

10 Reenter the password you selected to confirm it and click on the OK button.
The window closes and focus returns to the report window. The report is now
protected so that it can be forwarded to the appropriate individual(s); make sure that
those individuals have the password to open the document, if one is required.
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Working with Permanency Hearing Reports
The Permanency Hearing Report supplies the court with the information necessary to make
decisions regarding the safety and well-being of a child in foster care (or a child in the direct
custody of a relative or other suitable person [under Article 10 of the Family Court Act]), as well
as the appropriateness of the plan for the child, the family’s progress and the agency’s provision
of reasonable efforts to finalize the child’s Permanency Planning Goal (PPG).
While you may be concerned about biological or foster parents viewing the contents of a
Permanency Hearing Report, as part of good casework practice, you must engage them in a
case consultation in order to obtain input for the report and this consultation must occur within
60 days prior to the permanency hearing Date Certain. As part of this consultation, you should
inform all individuals involved in planning for the child of the agency’s plan(s) and the steps
being taken to achieve it; including full disclosure about
concurrent planning activities. For children in foster care, full
disclosure is critical to achieving permanency and such
disclosure should have occurred on other occasions prior to the
permanency hearing (e.g., at a Service Plan
Information that does not pre-fill
Review/Consultation).
reports includes:

Permanency Hearing Reports should contain information based
on Service Plan Reviews/Consultations and other meetings that
occur during the life of a case.

•

Information from template
FASPs

•

HIV information

•

Diagnoses of/related to
HIV/AIDS recorded on the
Clinical Appointment tab

When launching a report, you have the option to pre-fill the
report with information from the last approved FASP or Plan
Amendment. Information from the Health Services and
Education areas of CONNECTIONS also pre-fills. You do not
have the option to pre-fill only specific sections of the report;
however, you can modify the narrative responses that pre-fill.

•

Reasons for hospitalization

•

Health Narrative

When you select “Pre-fill” for a Multiple Child report, the
narrative answers for each child display, preceded by the name
of the child with which the answer corresponds.

For more information, see the
caseworker guide, “A Guide for
Caseworkers: Completion of the
Permanency Hearing Report” at

The Pre-fill Option

It is very important to thoroughly review all pre-filled responses
in a pre-fill report to ensure that they are timely, accurate and
appropriate, and fully respond to the question. Never assume
that pre-filled answers are entirely accurate, since some
information in the source of the answers (e.g., the last approved
FASP) could be outdated. In addition, there may be times when
multiple “answers” pre-fill one question in the report, requiring
you to edit the response. For example, if you are completing a
Multiple Child report, the responses for all children will pre-fill
narratives. You need to review the responses and modify them
so that they form one cohesive, concise response, rather than
three separate entries (see page 20 for information on modifying
Permanency Hearing Report information).

No mention of HIV/AIDS should
be made in the Permanency
Hearing Report.

http://www.ocfs.state.ny.us/main
/legal/legislation/permanency/
caseworkerguide.asp

In order to help you determine
which pre-filled report
information you can modify,
modifiable information displays
in gray highlighting.
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The Drop-down Launch Field
Use the drop-down field above the Launch button to choose
whether to pre-fill a Permanency Hearing Report with
information from other areas of CONNECTIONS. The field
contains “Pre-fill” and “No Pre-fill” options.
If you select the “No Pre-fill” option, only demographic, PPG
and case/stage information will be included in the report. With
the exception of worker phone numbers, this information is not
modifiable. You can then enter your own narratives in other
areas of the report.

If demographic information that
pre-fills is incorrect, you can
delete the draft Permanency
Hearing Report, go to the
appropriate areas of
CONNECTIONS to fix the
demographic information, and
regenerate the report.

If you select “Pre-fill,” CONNECTIONS will populate not only
demographic, PPG and case/stage information, but it will also
populate many of the permanency hearing report responses with answers from the last
approved FASP or Plan Amendment, whichever is most recent, as well as information from
Health Services and Education.
For example, Question 12a of the Permanency Hearing Report
states:
“If the permanency goal is Another Planned Permanent Living
Arrangement:
a. Provide the compelling reason for determining that it would
not be in the best interests of the child to be returned home,
placed for adoption, placed with a legal guardian, or placed with
a fit and willing relative.”
The answer to this question will pre-fill from the Tracked
Children Detail narrative question stating:
“Explain the reason for the PPG change and describe the
reason(s) why it is not in the best interest of the child to do any
of the following: return to parent, place for adoption, refer for
guardianship, or place with a relative.”

See Appendices A, B and C for
a sample of all three types of
Permanency Hearing Reports.
The appendices contain detailed
mapping information regarding
from where in CONNECTIONS
the fields are populated.
Questions that are pre-filled and
modifiable are so noted in red.
Questions that do not pre-fill
(you must record a response)
are also identified as such.

When you select “Pre-fill” for a Multiple Child report, the narrative answers for each child
display, preceded by the name of the child to whom the answer corresponds. You can modify all
pre-filled narrative responses.

Launching a Permanency Hearing Report
Both the Individual Child and Multiple Child Permanency
Hearing Reports can only be launched for FSS/CWS stages;
the Freed Child Permanency Hearing Report can only be
launched for FSS/CCR stages. A Multiple Child Permanency
Hearing Report can only be launched if all children selected for
the report have the same Date Certain.

Due to confidentiality issues,
you should not launch a Multiple
Child Permanency Hearing
Report when multiple biological
fathers are involved.

The Launch button will not enable when the Active All or All
radio button is selected. The Launch button will also not enable
when the Active <21 radio button is selected and the child(ren) selected in the grid does not
have a PPG or a Program Choice of “Placement” or “Non-LDSS Custody.”
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Launch Edits
Launching a Permanency Hearing Report involves the simple steps of selecting the child(ren),
making a pre-fill/no pre-fill selection, and clicking on the Launch button; however, when the
Launch button is clicked, CONNECTIONS performs a series of behind-the-scenes edits.

Individual and Freed Child Report Edits
After clicking on the Launch button, the following edits will be performed:
1. CONNECTIONS will check to see if there is an in-process (“Draft”) Permanency
Hearing Report for the child. If there is, the following message will display:
“A child can only have one Permanency Report in process at a time.”
Click on the OK button to close the message.
2. If a child does not have an in-process Permanency Hearing Report and “No Pre-fill”
was selected, the Permanency Hearing Report will display in the Permanency Hearing
Report window with only demographic and case/stage information.
3. If a child does not have an in-process Permanency Hearing Report and “Pre-fill” was
selected, CONNECTIONS will check for an approved FASP or Plan Amendment.
•

If no approved FASP or Plan Amendment exists, the following message will
display:

“No approved FASP, Plan Amendment, or Removal Update Report exists, no pre-fill
available for FASP information, continue?”
Click on the Yes button to proceed with generating a non-pre-filled report; click
on the No button to stop the report launch and return to the Permanency window.
•

If CONNECTIONS locates an approved FASP or Plan Amendment, the pre-filled
report displays in the Permanency Hearing Report window.

Multiple Child Report Edits
After clicking on the Launch button, the following edits will be performed:
1. CONNECTIONS will check to see if all children selected have the same Date Certain;
if they do not, the following message will display:
“All children must have the same Hearing Date Certain that are involved in the report.”
Click on the OK button to close the message.
2. CONNECTIONS will check to see if there is an in-process (“Draft”) Permanency
Hearing Report for any of the children. If there is, the following message will display:
“A child can only have one Permanency Report in process at a time.”
Click on the OK button to close the message.
3. If no children have an in-process Permanency Hearing Report and “No Pre-fill” was
selected, the Permanency Hearing Report will display in the Permanency Hearing
Report window with only demographic and case/stage information.
4. If no children have an in-process Permanency Hearing Report and “Pre-fill” was
selected, CONNECTIONS will check for an approved FASP or Plan Amendment.
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•

If no approved FASP or Plan Amendment exists, the following message will
display:

“No approved FASP, Plan Amendment, or Removal Update Report exists, no pre-fill
available for FASP information, continue?”
Click on the Yes button to proceed with generating a non-pre-filled report; click
on the No button to stop the report launch and return to the Permanency window.
•

If CONNECTIONS locates an approved FASP or Plan Amendment, the pre-filled
report displays in the Permanency Hearing Report window.

Step-by-Step:
Launching a Pre-filled Individual Child
(or Freed Child)
Permanency Hearing Report
1

Select the child from the Child List by clicking on the
gray box to the left of his/her name.
The Launch button and field above enable; “Pre-fill”
is automatically selected.

2

Click on the Launch button.
If all edits are passed, the Permanency Hearing
Report displays in the Permanency Hearing Report
window.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab

Step-by-Step:
Launching a Pre-filled Multiple Child Permanency Hearing Report
1

Select the children from the Child List by holding down the Ctrl key on your keyboard
while clicking on the gray boxes to the left of their names.
The Launch button and field above enable; “Pre-fill” is automatically selected.

2

Click on the Launch button.
If all edits are passed, the Permanency Hearing Report displays in the Permanency
Hearing Report window.
Step-by-Step:
Launching a Non-Pre-filled Individual Child (or Freed Child)
Permanency Hearing Report

1

Select the child from the Child List by clicking on the gray box to the left of his/her
name.
The Launch button and field above enable; “Pre-fill” is automatically selected.

2

Click on drop-down arrow and select “No Pre-fill.”

3

Click on the Launch button.
If all edits are passed, the Permanency Hearing Report displays in the Permanency
Hearing Report window.
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Step-by-Step:
Launching a Non-Pre-filled Multiple Child Permanency Hearing Report
1

Select the children from the Child List by holding down the Ctrl key on your keyboard
while clicking on the gray boxes to the left of their names.
The Launch button and field above enable; “Pre-fill” is automatically selected.

2

Click on drop-down arrow and select “No Pre-fill.”

3

Click on the Launch button.
If all edits are passed, the Permanency Hearing Report displays in the Permanency
Hearing Report window.

The Permanency Hearing Report Window
You can use the Permanency Hearing Report window to view, modify and print Permanency
Hearing Reports. The window contains the appropriate features to allow you to modify a report,
including a text control tool; Save, Cancel and Close buttons; and the Final checkbox.
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Modifying a Permanency Hearing Report
Modifying/recording information on this window is very similar to working in Microsoft Word. The
text control tool allows you to perform such functions as creating bulleted lists, changing fonts
and printing the report; the Printer icon is always enabled. Modifiable information within the
report displays in gray highlighting.
You do not have to complete a Permanency Hearing Report all
at once. You can choose to record and save as much
information as you wish and return to the report as many times
as you need to in order to complete it. A report remains in
“Draft” status until you select the Final checkbox at the bottom
of this window and save it, which freezes the report; you cannot
modify a report once it is marked “Final” and saved. Once
checked and saved, the Final checkbox cannot be unchecked.
The Save, Cancel and Close functions are also available as
commands in the File menu. When this window opens as a
result of launching a new report, the Save button is enabled;
however, when this window is opened by accessing a “Draft”
report from the Permanency Report Summary grid, the Save
and Cancel buttons do not enable until you make a change to
the report. Clicking on the Cancel button displays the following
message when unsaved changes exist:
“Do you want to cancel?
Unsaved data and/or narrative(s) will be lost.”

Be certain you have a clear
understanding of your agency’s
policy regarding who is
designated to mark the
Permanency Hearing Report
“Final.”

If you are modifying a report at
the same time as another
worker, the first worker to click
on the Save button is the worker
whose information is saved in
the report.

•

Click on the Yes button to cancel the changes; all
changes made are lost and the Permanency Hearing Report window remains open.

•

Click on the No button to end the cancellation request and return focus to the
Permanency Report window.

Clicking on the Close button after making changes, but before saving them, displays the
following message:
“Do you want to exit?
Unsaved data and/or narratives will be lost.”
•

Click on the Yes button to close the window; the changes are not saved.

•

Click on the No button to return to the Permanency Hearing Report window with the
unsaved changes displayed.
Step-by-Step:
Modifying a Permanency Hearing Report
1

Access the desired Permanency Hearing Report by
either launching a new report (see page 18) or
following Steps 1-2 on page 12 to open an inprocess (“Draft”) report.
The Permanency Hearing Report window displays
with the desired Permanency Hearing Report.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab
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2

Make the appropriate changes to the report.

3

Click on the Save button to save the changes.

4

Click on the Close button to close the Permanency Hearing Report window.

Marking a Permanency Hearing Report “Final”
There is no system approval process for Permanency Hearing
Reports in CONNECTIONS; however, your agencies may
develop their own procedures for approving Permanency
Hearing Reports outside of CONNECTIONS. For example, your
agency could choose to have a supervisory and legal review of
Permanency Hearing Reports. Since a report cannot be
modified once it’s marked “Final,” Permanency Hearing Reports
should remain in “Draft” status until the review and approval
process your agency requires is complete. This way, you (or
other designated worker[s]) can make the appropriate changes
to the report as a result of the review. Then, once all changes
have been made and the report is approved, the designated
person can mark the report as “Final.”

The Permanency Hearing
Report should be marked “Final”
and saved without making any
additional changes only after the
worker completing the
Permanency Hearing Report is
notified by the ACS FCLS
attorney that the report has
been approved.

Step-by-Step:
Marking a Permanency Hearing Report “Final”
1

Access the desired Permanency Hearing Report by
either launching a new report (see page 18) or
following Steps 1-2 on page 12 to open an inprocess (“Draft”) report.
The Permanency Hearing Report window displays
with the desired Report.

Where am I?

2

Make sure all appropriate changes have been made
to the report.

Assigned Workload > FSS >
Tasks > Permanency tab

3

Click on the Final checkbox.

4

Click on the Save button.
The following message displays:
“Indicating the report is Final will not allow for future modifications. Do you wish to
continue?”

5

Click on the Yes button to change the report Status to “Final.”
The changes are saved and the report is in “Final” status.
—OR—
Click on the No button to keep the report in “Draft” status.
The Final checkbox is unchecked and changes made are not saved; you must click
on the Save button to save any other changes you made.

6

Click on the Close button to close the Permanency Hearing Report window.
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Printing a Permanency Hearing Report
Once a report is launched and saved, it is available for printing only by clicking on the Print icon
on the Permanency Hearing Report window. Reports are available for printing even after the
FSS stage is closed. The header of the Freed Child Permanency Hearing Report contains the
report title (i.e., “Permanency Hearing Report”), the Docket Number and the Case Number; the
Individual Child and Multiple child reports contain the following header information:
Report Title

The following title displays:
“Permanency Hearing Report”

Warning Message

The following warning message displays:
“****WARNING****
Confidential Information
Authorized Personnel Only”

Draft

“Draft” displays if the report is in “Draft” status at the time it is printed;
if the report is in “Final” status, “Draft” does not display.

Docket Number

The Docket Number recorded on the Permanency Hearing Report
window.

Case Number

The Case Number of the case to which the report is associated.

Report footers contain the following information:
Date Printed

The date the Permanency Hearing Report was printed.

Page Numbers

Page numbers display in X of X format (e.g., Page 1 of 19).

OCFS Form Name

The form name that displays depends on the report type (i.e., “PH-1
Individual Child,” “PH-2 Multiple Child” or “PH-3 Freed for Adoption”).

Step-by-Step:
Printing a Permanency Hearing Report
1

2

Access the desired Permanency Hearing Report by
either launching a new report (see page 18) or
following Steps 1-2 on page 12 to open an inprocess (“Draft”) report.
The Permanency Hearing Report window displays
with the desired Permanency Hearing Report.
Click on the Print icon ( ).
The report prints to the designated printer.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab
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Deleting a Draft Permanency Hearing Report
Since there is no system approval process for Permanency Hearing Reports, “Draft”
Permanency Hearing Reports can be deleted from the system. For example, if you choose to
pre-fill a report and discover that the demographic information pulled into the report is incorrect,
you can simply delete the report (as long as it is in “Draft” status), make the necessary changes
in CONNECTIONS and launch a new one. You cannot delete certain sections of a report; the
entire report is deleted. Reports are deleted from the Permanency Report Summary grid on the
Permanency window.
Clicking on the Delete button deletes not only the Permanency Hearing Report from the system,
but its associated Notices and Statement as well.
Step-by-Step:
Deleting a Draft Permanency Hearing Report
1

Select the child from the Child List.
The Permanency Report Summary grid populates.

2

Select the desired “Draft” Permanency Hearing
Report from the grid.
The Delete button enables.

3

Click on the Delete button.
The following message displays:

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab

“Are you sure you want to delete this permanency
hearing report? All information will be lost?”
4

Click on the Yes button to delete the report (and
Notices and Statement).
OR
Click on the No button to keep the report (and
Notices and Statement) in the system.

The Delete button will not
enable if the Report Status
is “Final.”
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Permanency Hearing Notices and Statement
The Permanency Hearing Notices and Statement are generated and maintained in
CONNECTIONS as part of the associated Permanency Hearing Report’s record. Deleting a
“Draft” Permanency Hearing Report deletes the record of its associated Notices and Statement,
as well.
The Permanency Hearing Statement is to be submitted only to
the court, along with the Permanency Hearing Report. The
Statement lists all those who received Notice of the permanency
hearing, along with their address, their relationship to the
child(ren) who is the subject of the hearing, and the date the
Notice was mailed to the them. Court information (e.g., Judge’s
name, name of court) also displays on the Statement.

The Statement is confidential
and should not be shared
with anyone or any entity
except the court.

Permanency Hearing Notices are sent to legally required parties to inform them of the date, time
and location of an upcoming permanency hearing. The Notice includes such information as the
name(s) of the child(ren) who is the subject of the permanency hearing; the court name and
address; the permanency hearing date and time; the Petitioner’s name, address and phone
number; and the name, address and phone number of the Petitioner’s attorney.
Notice of the Permanency Hearing and the Permanency Hearing Report must be provided to:
•

the child’s parent, including any non-respondent parent (unless parental rights have
been terminated);

•

any other person legally responsible for the child;

•

the foster parent in whose home the child currently resides, if applicable;

•

the child’s law guardian;

•

the attorney for the respondent parent, if applicable;

•

the agency supervising the child’s care, if applicable;

•

any pre-adoptive parent; and

•

any relative providing care for the child.

All former foster parents within whose home the child resided for a continuous period of 12
months must be provided only with Notice of the permanency hearing; they are not to receive
the Permanency Hearing Report. This requirement is to be met regardless of whether the foster
boarding home remains open or has since closed.
Chapter 437 of the Laws of 2006, effective July 26, 2006, amended section 1089(b)(2) of the
Family Court Act as follows:
The notice of the permanency hearing only shall be provided to a former foster parent in
whose home the child previously had resided for a continuous period of twelve months in
foster care, if any, unless the court, on motion of any party or on its own motion,
dispenses with such notice on the basis that such notice would not be in the
child's best interests.
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It is the intent of the law that no possible supportive relationship be overlooked when the court
must determine if the plan presented by the district meets the child’s needs for timely
permanency. If a placement lasted 12 months or more, it is likely that at least for some portion
of that time, the child and the foster parent developed a relationship. Therefore, by sending
them a notice, the district is providing the former foster parent with an opportunity to consider if
they are willing and able to play a supportive role in that child’s life at this time.
There may be reasons why the district believes that it is inappropriate to notify a former foster
parent of an upcoming Permanency Hearing, including the abuse/maltreatment of the child in
that home, a damaging emotional relationship, etc. If the district has safety concerns regarding
the former foster parent, then the district should address those concerns with the court and
request the court to relieve the district of the obligation to provide notice. This may be done by a
motion to the court prior to the Permanency Hearing.

The Permanency Hearing Notices and Statements Window
The Permanency Hearing Notices and Statements window is the location in CONNECTIONS
where you will select invitees for the permanency hearing, record the court information that
populates the Notices and Statement, and print the Notices and Statement. Any worker with a
role in the FSS/CWS or FSS/CCR stage may view and/or modify the information on this
window.
This window is accessed from the Permanency window by clicking on the Notices and
Statement button. Since the Notices and Statement are associated to a specific Permanency
Hearing Report, the Notices and Statement button does not enable until you select a report
from the Permanency Report Summary grid.
Step-by-Step:
Accessing the Permanency Hearing Notices and Statements Window
1

Select the appropriate Permanency Hearing Report
from the Permanency Report Summary grid.
The Notices and Statement button enables.

2

Click on the Notices and Statement button.
The Permanency Hearing Notices and Statements
window displays.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab
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The Permanency Hearing Notices and Statements window is comprised of a header, footer,
Stage Composition grid, Outside Participants grid, VA Workers grid, Permanency Hearing
Invitees grid, and various fields and buttons.

The header contains the Stage ID and Case ID, as well as File, Options, Reports and Help
menus. The footer contains the Court Information, Save, Cancel and Close buttons, as well
as a Complete checkbox; details of these components follow:
Court Information
button

Clicking on this button displays the Court Information window,
which is used to record information about the court that will
display on the Notices and Statement. This includes such
information as the Court Part or Room, Judge’s name and docket
number. For more information on this window, see page 37. The
window can also be accessed by clicking on the Options menu
and selecting the Court Information command.

Save button

This button enables after a row is added to the Permanency
Hearing Invitees grid, when you record a Date Mailed, or when
you uninvite an invitee. Clicking on this button (or selecting the
Save command from the File menu) saves your changes; the
window stays open.
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Cancel button

This button enables after a row is added to the Permanency
Hearing Invitees grid, when you record a Date Mailed, or when
you uninvite an invitee. Clicking on this button (or selecting the
Cancel command from the File menu) after making changes, but
before saving them, displays the following message:
“Do you want to cancel?
Unsaved data and/or narrative(s) will be lost.”

Close button

•

Click on the Yes button to cancel the changes; all changes
made are lost and the Permanency Hearing Notices and
Statements window remains open.

•

Click on the No button to end the cancellation request and
return focus to the Permanency Hearing Notices and
Statements window.

This button is always enabled. Clicking on this button (or selecting
the Close command from the File menu) after making changes,
but before saving them, displays the following message:
“Do you want to exit?
Unsaved data and /or narratives will be lost.”

Complete checkbox

•

Click on the Yes button to close the window; the changes
are not saved.

•

Click on the No button to return to the Permanency
Hearing Notices and Statements window with the unsaved
changes displayed.

A checkmark automatically populates this box after you complete
the Court Information window and save your recorded
information.
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Permanency Hearing Invitees
The Stage Composition, Outside Participants and VA Workers grids are used to add
permanency hearing invitees, who are the individuals you designate to receive Permanency
Hearing Notices. As you add individuals from these grids using the Add to Invitees button (or
the Add to Invitees command in the Options menu), they will
populate the Permanency Hearing Invitees grid. Information on
the individuals that populate each grid follows:
Stage Composition

Outside Participants

This grid lists all active stage
members 18 years of age or
older who have a relationship to
the selected child(ren) of
“Mother,” “Father,” “Alleged
Father” or “Putative Father” (as
recorded on the Family
Relationship Matrix window).
This grid lists all individuals
recorded on the Outside
Participants window, including
their Interest (i.e., relationship)
as recorded on that window.

Since information is pulled from
the Family Relationship Matrix,
it is critical to make sure that the
relationships are recorded
accurately there.

With Build 18.9, the Outside
Participants window can be
accessed not only from within
the Service Plan Review
functionality in CONNECTIONS,
but also from the Stage
Composition tab by clicking on
the Options menu and selecting
the Add Outside Participants
command.

VA Workers

This grid lists all workers who
currently have a role in the stage
and are from a voluntary
agency; their agency’s name
also displays.

Permanency Hearing
Invitees

This grid populates with
For more information on this
individuals as they are added
window, see page 30.
from the grids above and will be
used to develop the list of individuals for whom Notices can be
generated and printed.

The Permanency Hearing Invitees Grid
As individuals are added from the Stage Composition, Outside Participants and VA Workers
grids, they will populate the Permanency Hearing Invitees grid and the Save and Cancel
buttons will enable. Multiple individuals can be saved to grid at the same time; you do not need
to save after each person is added. This grid contains the following fields:
Invitee Name

The name of the person selected to receive a Permanency Hearing
Notice, as populated from the above grids.

Agency Name

The agency name of the voluntary agency worker, as populated from
the VA Workers grid.

Interest

The Interest of the outside participant, as populated from the Outside
Participants grid.
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Associated To

The child(ren) to whom the invitee is associated, as recorded on the
Associated Child window. If an outside participant or voluntary
agency worker has an association to multiple children or parents, s/he
will appear in the Permanency Hearing Invitees grid only once and
the Associated To field will contain all associated children and/or
parents.

Date Mailed

The date the Permanency Hearing Notice was mailed to the invitee;
you will record the date within this grid (see page 44 for more
information on recording the mailing date).

Generated Date

The date the Permanency Hearing Notice was generated in
CONNECTIONS. This field is system-populated.

Placement From

The start date of the foster home placement for an Outside
Participant with an Interest of “Former Foster Parent,” as recorded in
the Dates of Placement: From field.

Placement To

The end date of the foster home placement for an Outside Participant
with an Interest of “Former Foster Parent,” as recorded in the Dates
of Placement: To field.

Adding Invitees from the Stage Composition Grid
Selecting a person from the Stage Composition grid enables the Add to Invitees button. Simply
click on the button to add the person to the Permanency Hearing Invitees grid.
If a parent added from the Stage Composition grid has differing relationships to different
children, s/he will display more than once in the Permanency Hearing Invitees grid, with a
different row for each child/relationship. For example, if John Doe is the “Father” of Christopher
and the “Alleged Father” of Michael, two lines will populate the Permanency Hearing Invitees
grid for John Doe: one for his relationship with each child.
Step-by-Step:
Adding Invitees from the Stage Composition Grid
1

Select a person from the Stage Composition grid.
The Add to Invitees button enables.

2

Click on the Add to Invitees button.
The Permanency Hearing Invitees grid populates
with the person’s name.

3

Click on the Save button.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement
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Adding Outside Participants: Accessing the Outside Participants Window
There are various times while working in a Family Services Stage (FSS) that you need to record
information about a person who is not part of the stage composition. For example, when you are
preparing Visiting Plans or scheduling Service Plan Reviews, outside participants need to be
involved and so listed in CONNECTIONS. This is done by clicking on the Add Outside
Participants button within the Visiting Plan tab on the Visiting Plan window and the Persons
tab on the Service Plan Review Details window. With the implementation of Build 18.9, you will
also need to record information about people who are not part of the stage composition but
should receive the Permanency Hearing Report and/or receive Notice of the permanency
hearing.
To add an outside participant for a Permanency Hearing, you will navigate to the Outside
Participants window by selecting the Add Outside Participants command from the Options
menu on the Family Services Stage window. Just as when you click on the Add Outside
Participants button on the Visiting Plan tab on the Visiting Plan window and the Persons tab
on the Service Plan Review Details window, the Outside Participants window will display.

With the implementation of Build 18.9, the Outside Participants window introduces a new field:
the Interest field. This field is used to document the role the person has in relationship to the
family. When the Outside Participants window is accessed through the Family Services Stage
window, the Interest field is enabled and required. You are allowed to select one and only one
Interest for each person entered.
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The following options are available in the Interest field:
•

Sibling

•

Other Family Member

•

Law Guardian

•

Half Sibling

•

Legal Guardian

•

Other

•

Step-Sibling

•

Legal Custodian

•

Other District/Agency Staff

•

Step-Parent

•

None

•

Parent/Guardian Attorney

•

Great Grandparent

•

CASA Volunteer

•

Pre-adoptive Parent

•

Grandparent

•

Caseworker

•

Probation

•

Aunt/Uncle

•

Foster Child

•

Relative

•

Niece/Nephew

•

Foster Parent

•

School Personnel

•

Cousin

•

Guardian

•

Service Provider

•

Third Party Reviewer

•

Tribal Representative

•

Qualified Expert Witness

•

Former Foster Parent

•

Other Suitable Person

Step-by-Step:
Adding an Outside Participant via the Family Services Stage Window
1

On the Family Services Stage window, click on the
Options menu and select the Add Outside
Participants command.
The Outside Participants window displays. Any
outside participants who were previously added to
the stage display in the list section. Required fields
highlight in yellow.

Where am I?
Assigned Workload > Tasks >
Family Services Stage

2

Record the person’s name in the Last Name and
First Name fields.

3

In the Interest field, click on the drop-down arrow and select the individual’s interest
from the resulting list

4

In the Agency field, type in the name of the individual’s agency, if applicable.

5

In the Participant Address section, record the individual’s address.

6

When you have recorded the address, click on the Validate button.
The Address Validation window displays.

7

Click on the Accept button to accept the validated address, as applicable.

8

Record phone, fax and e-mail information in the respective fields; as applicable.

9

When you are finished recording information for this person, click on the Add button.
The information is added to the Outside Participants list.

10 Click on the Save button.
11 Repeat this process for each outside participant.
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Step-by-Step:
Modifying an Outside Participant via the Family Services Stage Window
1

On the Family Services Stage window, click on the Options menu and select the
Add Outside Participants command.
The Outside Participants window displays. Any outside participants who were
previously added to the stage display in the list section. Required fields highlight in
yellow.

2

Select the person you wish to modify from the Outside Participants list.
The selected person’s information populates the data fields.

3

Make any necessary changes in the respective fields.

4

When you have finished recording information for this individual, click on the Modify
button.

5

Click on the Save button.

Step-by-Step:
Deleting an Outside Participant via the Family Services Stage Window
1

On the Family Services Stage window, click on the Options menu and select the
Add Outside Participants command.
The Outside Participants window displays. Any outside participants who were
previously added to the stage display in the list section. Required fields highlight in
yellow.

2

Select the person you wish to delete from the Outside Participants list.
The selected person’s information populates the data fields.

3

Click on the Delete button.
The selected person’s information is deleted from the Outside Participants list.

4

Click on the Save button.

Adding Invitees from the Outside Participants Grid
When adding an invitee from the Outside Participants grid, it
may be necessary to associate the outside participant to the
appropriate child or parent, and/or to record the associated
child’s dates of placement. For example, children can be
associated to their former foster parent(s) and parents can be
associated to their attorneys. These functions are completed
using the Associated Child window, the Associated Parent
window and the Dates of Placement fields. The Add to
Invitees button will not enable until any associations and dates
of placement are recorded, if required.

When you navigate to the
Outside Participants window
through the Family Services
Stage window, you can only
delete a person that was
added using the same
navigational path.
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The Associated Child Window
The Associated Child window is accessed by clicking on the Associated Child ellipsis button
(…). This button enables when the associated report is a Multiple Child Permanency Hearing
Reports and the Interest of the outside participant is anything except “Parent/Guardian
Attorney.” This button also enables (and the window is required) when adding invitees from the
VA Workers grid for a Multiple Child Permanency Hearing Report (see page 36 for more
information); it is used within that functionality to associate a voluntary agency worker to the
appropriate child(ren).

The window consists of a checklist of all children named in the associated Multiple Child
Permanency Hearing Report; an All checkbox; OK and Cancel buttons; and File and Help
menus. These features allow you to select whether the outside participant (or voluntary agency
worker) is associated with all children listed, or to select the specific child(ren) the person is
associated with.
Upon entering the window, the All checkbox is selected by default, indicating an automatic
selection of all children listed; the OK and Cancel buttons are enabled. When the All checkbox
is selected, the checkboxes next to each child’s name are also selected. To select a single child
or multiple children, but not all children, deselect the checkbox(es) next to the name of the
child(ren) who is not associated; the All checkbox is also deselected.
Once you have selected the appropriate child(ren), click on the OK button to keep your changes
and close the window; clicking on the Cancel button closes the window without saving changes.
After clicking on the OK button, if you selected only one child on the Associated Child window,
that child’s name will display in the Associated Child field (on the Permanency Hearing Notices
and Statements window). If you selected multiple children, “Multiple” will display in the
Associated Child field.
If the associated Permanency Hearing Report is an Individual or Freed Child report and you
select a person in the Outside Participants grid whose Interest is “Parent/Guardian Attorney” or
“Former Foster Parent”—since the associated report is for a single child—the Associated Child
field populates and is not modifiable.
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The Associated Parent Window
The Associated Parent window is accessed by clicking on the Associated Parent ellipsis button
(…). This button enables for Individual Child and Multiple Child Permanency Hearing Reports
when the Interest of the person selected in the Outside Participants grid is “Parent/Guardian
Attorney.” This window is used to select the parent to whom the attorney (selected in the
Outside Participants grid) is associated.

The window consists of a checklist of all parents in the stage (i.e., any person with a relationship
of “Mother,” “Father,” “Alleged Father” or “Putative Father” to any child(ren) named in the report
as recorded on the Family Relationship Matrix window); an All checkbox; OK and Cancel
buttons; and File and Help menus. These features allow you to select whether the attorney
represents all parents listed, or select the specific parent the attorney represents.
Upon entering the window, the All checkbox is selected by default, indicating an automatic
selection of all parents listed; the OK and Cancel buttons are enabled. To select a single parent
or multiple parents, but not all parents, deselect the checkbox(es) next to the name of the
parent(s) who is not associated; the All checkbox is also deselected. Once you have selected
the appropriate parent(s), click on the OK button to keep your changes and close the window;
clicking on the Cancel button closes the window.
After clicking on the OK button, if you selected only one parent on the Associated Parent
window, that parent’s name will display in the Associated Parent field (on the Permanency
Hearing Notices and Statements window). If you selected multiple parents, “Multiple” will display
in the Associated Parent field.
The Dates of Placement Fields
When the Interest of the person selected in the Outside Participants grid is “Former Foster
Parent,” the Dates of Placement To and From fields must be used to record the date the child
entered and left the foster parent’s home; the Add to Invitees button will not enable until these
dates are recorded.
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Step-by-Step:
Adding an Invitee from the Outside Participants Grid
1

Select the outside participant from the grid.
If the Interest of the outside participant selected is
“Parent/Guardian Attorney,” the Associated Parent
ellipsis button (…) enables; proceed to Step 2.
OR

Where am I?

If the Interest is not “Parent/Guardian Attorney,”
proceed to Step 5.

Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement

2

Click on the Associated Parent ellipsis button (…).
The Associated Parent window displays; the All
checkbox is populated.

3

Unless you want all parents selected, select the parent(s) whom the attorney
represents by deselecting the appropriate checkbox(es), leaving the desired
parent(s) selected.

4

Click on the OK button.
The Permanency Hearing Notices and Statements window displays; skip to Step 9.

5

If the associated report is a Multiple Child Permanency Hearing Report and the
Interest of the outside participant is not “Parent/Guardian Attorney,” click on the
Associated Child ellipsis button (…).
The Associated Child window displays; the All checkbox is populated. Proceed to
Step 6.
OR
If the above condition does not apply, proceed to Step 8.

6

Unless you want all children selected, select the child(ren) to whom the outside
participant is associated by deselecting the appropriate checkbox(es), leaving the
desired child(ren) selected.

7

Click on the OK button.
The Permanency Hearing Notices and Statements
window displays.

8

If the Interest of the outside participant is “Former
Foster Parent,” the Dates of Placement To and
From fields enable; record the dates of placement in
those fields.
OR
If the Interest is not “Former Foster Parent,” proceed
to Step 9.

9

If the Add to Invitees button
is not enabled, one or more
required windows or fields
(i.e., Associated Parent,
Associated Child and/or
Dates of Placement) have not
been completed.

Click on the Add to Invitees button.
The Permanency Hearing Invitees grid populates with the outside participant.

10 Click on the Save button.
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Adding Invitees from the VA Workers Grid
If the associated Permanency Hearing Report is an Individual Child or Freed Child report,
selecting an invitee from the VA Workers grid enables the Add to Invitees button; you do not
need to record associations or dates of placement in order to add the person. However, when
the associated report is a Multiple Child Permanency Hearing Report, you are required to
associate the voluntary agency worker to the appropriate child(ren). This function is completed
using the Associated Child window (see page 33 for information on this window). The Add to
Invitees button will not enable until the association(s) are recorded.
Step-by-Step:
Adding an Invitee from the VA Workers Grid
1

Select the voluntary agency worker from the grid.
If the associated report is a Multiple Child
Permanency Hearing Report, the Associated Child
ellipsis button (…) enables; proceed to Step 2.
OR
If the associated report is an Individual Child or
Freed Child Permanency Hearing Report, proceed
to Step 5.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement

2

Click on the Associated Child ellipsis button (…).
The Associated Child window displays; the All checkbox is populated.

3

Unless you want all children selected, select the child(ren) to whom the voluntary
agency worker is associated by deselecting the appropriate checkbox(es), leaving
the desired child(ren) selected.

4

Click on the OK button.
The Permanency Hearing Notices and Statements
window displays.

5

Click on the Add to Invitees button.
The Permanency Hearing Invitees grid populates
with the voluntary agency worker.

6

Click on the Save button.

If the Add to Invitees button is
not enabled, the Associated
Child window has not been
completed (for a Multiple Child
Permanency Hearing Report).
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Deleting Invitees
If you discover that you invited a person in error or want to
remove a person from the Permanency Hearing Invitees grid for
another reason, you can uninvite that person. Simply select the
person from the grid and click on the Uninvite button (or the
Uninvite command in the Options menu). You can uninvite
multiple people at one time by selecting them from the grid and
clicking on the Uninvite button.

You must have saved an invitee
to the grid by clicking on the
Save button before the Uninvite
button will enable.

Step-by-Step:
Deleting an Invitee
1

Select the invitee from the Permanency Hearing
Invitees grid.
The Uninvite button enables.

2

Click on the Uninvite button.
The selected row is deleted from the grid.

3

Click on the Save button.

The Court Information Window

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement

The Court Information window is the location in CONNECTIONS where you will record the court
information that populates the Notices and Statement. All fields (with the exception of Court
Part or Room) in both sections must be completed in order to generate a Permanency Hearing
Notice or Statement. Once all required fields are complete and saved, the Complete checkbox
on the Permanency Hearing Notices and Statements window is automatically populated.
Any worker with a role in the FSS/CWS or FSS/CCR stage may view and/or modify information
on this window. This window is accessed from the Permanency Hearing Notices and
Statements window by clicking on the Court Information button. (The Court Information
button enables once individuals are added and saved to the Permanency Hearing Invitees
grid).
Step-by-Step:
Accessing the Court Information Window
1

Click on the Court Information button.
The Court Information window displays.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement
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The Court Information window is comprised of a Family Court Address section and Hearing
Information section, both which contain various fields.

The window also contains the standard header with the Case ID and Stage ID, as well as File,
Options and Help menus. The footer contains the standard Save, Cancel and Close buttons,
which are also available as commands in the File menu:
Save

This button enables once information has been recorded or modified
on the window and the court address has been validated. Clicking on
this button saves your changes; the window stays open.

Cancel button

This button enables once information has been recorded or modified
on the window. Clicking on this button after making changes, but
before saving them, displays the following message:
“Do you want to cancel?
Unsaved data and/or narrative(s) will be lost.”
•

Click on the Yes button to cancel the changes; changes are
lost and the Court Information window remains open.

•

Click on the No button to end the cancellation request and
return focus to the Court Information window.
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Close button

This button is always enabled. Clicking on this button after making
changes, but before saving them, displays the following message:
“Do you want to exit?
Unsaved data and /or narratives will be lost.”
•

Click on the Yes button to close the window; the changes are
not saved.

•

Click on the No button to return to the Court Information
window with the unsaved changes displayed.

Family Court Address
The Family Court Address section is used to record the court’s address. It contains the following
fields, which are always enabled:
•

Street 1

•

P.O. Box/Apt

•

City

•

State (defaults to NY)

•

Zip

The section also contains a Validate button, which enables once information is entered into the
Street 1, P.O. Box/Apt, City or State fields. Once you enter the court’s address, you must
validate it by clicking on the Validate button (or by selecting the Validate command from the
Options menu). Doing so displays the address validation window, containing the address you
entered, the validated address, and Accept and Reject buttons. Click on the Accept button to
accept the validated address, which will populate the fields in the Family Court Address section;
the Save button enables. Click on the Reject button to reject the validated address and keep
the address you recorded, which populates the fields in the Family Court Address section; the
Save button enables. You do not have to accept a validated address in order for the Save
button to enable; however, you do have to accept a validated address in order for the Complete
checkbox to populate on the Permanency Hearing Notices and Statements window.

Hearing Information
The Hearing Information section is used to record information regarding the upcoming
permanency hearing. It contains the following fields, which are always enabled and required,
unless otherwise noted:
Judge/Referee

This field is used to record the name of the Judge presiding over the
permanency hearing.

Attorney for
ACS/DSS

This field is used to record the name of the attorney representing the
local district/ACS.

Hearing Date
Certain

This field is populated with the Date Certain displayed on the
Removal Information tab on the Tracked Children Detail window for
the child(ren) named in the report. This field is enabled so that you
can modify the Date Certain if it has changed; however, if you select
the Verify System Response is Accurate checkbox, this field
disables.
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Verify System
Response is
Accurate checkbox

If the Date Certain displayed in the Hearing Date Certain field is
accurate, you must select this checkbox to verify it. The Hearing
Date Certain field will disable when this checkbox is selected;
however, you can deselect this checkbox to reenable the field.

Court

This field is used to record the name of the court where the
permanency hearing will be held.

Docket Number

This field is used to record the court-assigned Docket Number of the
permanency hearing.

Time of Hearing

This field is used to record the time of the permanency hearing.

Court Part or Room

This optional field is used to record the room in the courthouse where
the permanency hearing will take place.

Step-by-Step:
Recording Court Information
1

Record the primary street address of the court in the
Street 1 field.

2

If appropriate, record any necessary information in
the P.O. Box/Apt field.

3

Record the city of the court in the City field.

4

If the permanency hearing is not in New York State,
select the appropriate state by clicking on the dropdown arrow in the State field.

5

Enter the Zip Code of the court in the Zip field.

6

Validate the address by clicking on the Validate button.
The address validation window displays.

7

Accept the validated address by clicking on the Accept button.
The validated address populates the Family Court Address section.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement > Court
Information

OR
Reject the validated address by clicking on the Reject button.
The address you recorded populates the Family Court Address section.
8

Record the name of the Judge presiding over the permanency hearing in the
Judge/Referee field.

9

Record the name of the attorney for the local district (or ACS) in the Attorney for
ACS/DSS field.

10 Verify that the permanency hearing date in the Hearing Date Certain field is correct
by selecting the Verify System Response is Accurate checkbox.
OR
Record the correct date of the permanency hearing in the Hearing Date Certain
field.
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11 Record the name of the court where the hearing will be held in the Court field.
12 Record the Docket Number of the permanency hearing in the Docket Number field.
13 Record the time of the permanency hearing in the Time of Hearing field.
14 If appropriate, record the room in the courthouse where the permanency hearing will
be held in the Court Part or Room field.
15 Click on the Save button.

Printing the Permanency Hearing Notices and Statement
The Permanency Hearing Notices and Statement are available for printing from the Reports
menu on the Permanency Hearing Notices and Statements window. Once the court information
is recorded and saved, the Complete checkbox is checked, and there is at least one person
listed and saved in the Permanency Hearing Invitees grid, the
Print Notices and Print Statement commands under the
Reports menu will enable.
After printing, the Notices are sent to the invitees and the
Statement is sent to the Judge. Any worker with a role in an
FSS/CWS or FSS/CCR stage can print the Notices and/or
Statement.

The Print Notices Window

ACS workers will continue to
print Permanency Hearing
Notices and Statements from
LTS; do not use
CONNECTIONS to print Notices
and Statements.

Selecting the Print Notices command (from the Reports menu
on the Permanency Hearing Notices and Statements window) displays the Print Notices
window, where you can select for which individuals you want to generate and print Notices.
The window consists of a checklist of all individuals listed in the Permanency Hearing Invitees
grid; an All checkbox; OK and Cancel buttons; and File and Help menus.

Upon entering the window, the All checkbox is selected by default, indicating an automatic
selection of all invitees listed; the OK and Cancel buttons are enabled. When the All checkbox
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is selected, the checkboxes next to each invitee’s name are disabled; however, if you deselect
the All checkbox, the checkboxes enable.
Once you have selected the appropriate invitee(s), click on the OK button to keep your changes
and close the window; clicking on the Cancel button displays the following message when
unsaved changes exist:
“Do you want to cancel?
Unsaved data and/or narrative(s) will be lost.”
•

Click on the Yes button to cancel the changes; all changes made are lost and the
window closes.

•

Click on the No button to end the cancellation request and return focus to the
Permanency Hearing Notices and Statements window.

After clicking on the OK button, the Permanency Hearing Notice will display in a view-only print
preview window. If multiple invitees were selected, each Notice will display in the print preview
window with a page break between them.
Upon printing the Notice(s), the Generated Date field in the Permanency Hearing Invitees grid
will populate with the date the Notice was first printed for each invitee and the Date Mailed field
will enable.
Step-by-Step:
Printing the Permanency Hearing Notice(s)
1

Click on the Reports menu and select the Print
Notices command.
The Print Notices window displays; the All checkbox
is populated.

2

Unless you want all invitees selected, select the
invitee(s) you wish to print a Notice for by
deselecting the appropriate checkbox(es), leaving
the desired invitee(s) selected.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement

3

Click on the OK button.
The Notice(s) displays in a view-only print preview
window.

4

Click on the Print icon ( ).
The report prints to the designated printer and the
print preview window displays.

5

Click on the Close button to close the print preview
window.
The Print Notices window displays.

6

Click on the Cancel button to close the Print Notices
window.
The Permanency Hearing Notices and Statements window displays; the Generated
Date field in the Permanency Hearing Invitees grid populates with today’s date and
the Date Mailed field enables.

In order for the Print Notices
command to enable, the
Complete checkbox must be
populated and invitees added to
the Permanency Hearing
Invitees grid must be saved to
the grid (by clicking on the
Save button).
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Printing the Permanency Hearing Statement
Selecting the Print Statement command (from the Reports menu on the Permanency Hearing
Notices and Statements window) displays the Permanency Hearing Statement in a view-only
print window.
The Statement header contains the following information:
Report Title

The following title displays on the Statement:
“STATEMENT TO THE COURT OF PERMANENCY HEARING
REPORTS AND NOTICES SENT”

Warning Message

The following warning message displays:
“****WARNING****
Confidential Information
Authorized Personnel Only”

Docket Number

The Docket Number recorded on the Permanency Hearing Report
window.

Case Number

The Case Number of the case to which the report is associated.

The Statement footer contains the following information:
Date Printed

The date the Permanency Hearing report was printed.

Page Numbers

Page numbers display in X of X format (e.g., Page 1 of 19).

OCFS Form Name

The Statement form name is always “PH-4a.”

Warning Message

The following warning message displays:
“Confidential: For Court Use Only”

Step-by-Step:
Printing the Permanency Hearing Statement
1

Click on the Reports menu and select the Print
Statement command.
The Statement displays in a view-only print window.

2

Click on the Print icon ( ).
The report prints to the designated printer and the
print preview window displays.

3

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement

Click on the Close button to close the print preview
window.
The Permanency Hearing Notices and Statements window displays.
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Recording the Mailing Date
Once you print the Notice(s), you can record the date the Notice was mailed to the invitee(s) in
the Date Mailed field on the Permanency Hearing Invitees grid. This will help you keep a more
accurate record of permanency hearing preparation activities. While this field is not required, the
mailing date will not populate the Permanency Hearing Statement if you have not recorded one
in this field. A mailing date can be deleted if it is entered incorrectly; simply highlight the date
and press the Delete key on your keyboard.
Step-by-Step:
Recording the Mailing Date
1

Click on the appropriate invitee’s row in the
Permanency Hearing Invitees grid.

2

Record the date the Notice was mailed to the invitee
in the Date Mailed field.

3

Click on the Save button.

Where am I?
Assigned Workload > FSS >
Tasks > Permanency tab >
Notices and Statement
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Support Tools
Online Help
The CONNECTIONS Online Help feature provides descriptions for various windows, as well as
step-by-step instructions for common tasks. You can access Online Help at any time, from any
window in CONNECTIONS by clicking on the Help menu or pressing the F1 key on your
keyboard.
The Contents, Index and Search tabs in Online Help allow you to search for and navigate to
the topic(s) you need help on.
Step-by-Step:
Accessing Online Help
1

Click on the Help menu on the CONNECTIONS Toolbar.
The following list of commands displays:
Contents

A table of contents for the help facility with links to major sections.

How Do I?

Step-by-step instructions to help you complete tasks using
CONNECTIONS.

Window
Descriptions

Descriptions of windows in CONNECTIONS, along with information on
various fields.

DSS Policy

Online OCFS policy handbooks (under revision).

Help On This
Window

Window description help for your current window.

Help for Help

Instructions on how to use the help functionality.

About
CONNECTIONS

Information about the current CONNECTIONS version and build.

2

Click on a command from the Help menu.
The window related to your selection displays. In some cases, you will need to make
another selection in that window to obtain instructions. At the top of each window,
you’ll see additional buttons and menus. Use the Search button to search for specific
information in the Help function and use the Back button to return to windows you’ve
just visited in Help. The Glossary button opens a list of important CONNECTIONS
terms and the Print button allows you to print Help information.

3

When you’re done reviewing information in Help, close each Help window by clicking
on the Close button ( ) in the top right corner of the window.
The system returns to the window you were using when you accessed Help.
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Enterprise Help Desk
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff are available
to answer basic questions related to your equipment, or to solve problems you are having with
the CONNECTIONS application. If they cannot solve your problem, they will record your
information and forward it to others who can.
Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with
your supervisor before you call.
The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number
is:
1-800-NYS-1323
(1-800-697-1323)
When you call the Enterprise Help Desk with a problem, you will be given a ticket number to use
for tracking your issue and its resolution. Keep a record of this number; you will need it for any
follow-up conversations with the Enterprise Help Desk.

OCFS CONNECTIONS Intranet Site
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site
(http://ocfs.state.nyenet/connect/). The intranet site contains a wealth of information related to
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-byStep Guides (including the CONNECTIONS Case Management Step-By-Step Guide), Job Aids
and Frequently Asked Questions (FAQs).
Step-by-Step:
Accessing the OCFS CONNECTIONS Intranet Site
1

From your local desktop, double-click on the Internet Explorer icon.

2

If the browser does not display the OCFS intranet site automatically, enter
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on
your keyboard.
The OCFS intranet home page displays.

3

Click on the CONNECTIONS link.
The CONNECTIONS home page displays.

4

Click on a topic to access information.
For access to various Step-by-Step Guides and Job Aids, click on the Step-byStep/Job Aids/Tips link.

5

To close Internet Explorer, click on the File menu and select Close.
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Appendix A:
Individual Child
Permanency Hearing Report
Field Information
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PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

Fields with an * populate when the “No Pre-fill” option is selected.

PERMANENCY HEARING DATE CERTAIN: Pre-filled, not modifiable
Judge / Referee

Court

Part

Record

Record

Record

IN THE MATTER OF:
Child’s Name
Date of Birth
* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

Sex

Person ID (PID)

Docket Number

* Pre-filled,
not
modifiable

* Pre-filled, not
modifiable

Record

DATE OF REPORT PREPARATION: E
All information must be current and represent an update of events and circumstances since removal or the
previous Permanency Hearing
Case Name:

* Pre-filled, not
modifiable

Law Guardian:

Record

CONNECTIONS
Case ID:

* Pre-filled, not
modifiable

Record

Local Case #:

Record

Attorney for Parent(s) or
Person(s) Legally
Responsible:
Attorney for DSS/ACS:

Case Manager

* Pre-filled, not
modifiable

Phone:

* Pre-filled, modifiable

Case Planner

* Pre-filled, not
modifiable

Phone:

* Pre-filled, modifiable

Agency with
Planning
Responsibility:
Associated Case
Worker
Child Protective
Worker/Monitor

* Pre-filled, not
modifiable
Record

Phone:

Record

Pre-filled, modifiable

Phone:

Pre-filled, modifiable

Date Printed 03/06/2007

Record

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

PARENTS AND PERSONS LEGALLY RESPONSIBLE

Name

Relationship

* Pre-filled, not modifiable

* Pre-filled, not modifiable
Individuals with the following relationships display:
• Mother
• Father
• Alleged Father
• Putative Father
• Adoptive Mother
• Adoptive Father
• Legal Guardian
• Legal Custodian

Record (additional persons)

Record

Date Printed 03/06/2007

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

SECTION I. PERMANENCY PLAN SUMMARY
Child’s Name
Current Permanency
Planning Goal (PPG)

PPG/Date
Established

Anticipated PPG

* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

Select

* Pre-filled, not modifiable

Return to parent(s)
Placement for adoption
Referral for legal guardianship
Permanent placement with fit
and willing relative
Placement in another planned
permanent living arrangement
with significant connection to an
adult
For children with a Program Choice
of “Placement,” the above options
display.
For children with a Program Choice
of “Non-LDSS Custody,” the
following Anticipated PPG’s display:
1. Reunite with Parent
2. Legalize Living Arrangement
with Relative/Resource
3. Permanent Living
Arrangement (NonGuardianship/NonCustodian)

Date by which it is expected that the current or anticipated PPG will be accomplished: Record

Date Printed 03/06/2007

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

SECTION II. PERMANENCY PLANNING
1. If there is a plan for continuing placement for the child, describe the reason placement continues to be
necessary and in accordance with the best interests and safety of the child, including whether the child
would be at risk of abuse or neglect if returned to the parent or other person legally responsible.
Record

2. If there is a plan for continuing placement for the child, describe the efforts made since removal or the
last permanency hearing, if any, to locate any absent parent or relative(s) of the child and to notify each
of them of the child’s placement in foster care.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable based on the
following Foster Care Issues questions:
• Have all parents been identified? If “No,” the narrative for “Describe the efforts to identify them” pre-fills.
• Have all parents been located? If “No,” the narrative for “Describe all efforts to locate them, including
results from inquiries to the Parent Locator Service” pre-fills.
• Have you explored alternative permanency resources that may be available to the child should he or she
be unable to return home? If “Yes,” the narrative for “Have any potential resources been identified? Who
are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been explore?”
pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” you must record the response; it does not pre-fill.

3. State whether the absent parent or relative expressed an interest in obtaining custody of or planning for
the child, or whether any relative is interested in becoming a foster parent for the child. If interest has
been expressed, what has been done to further any of these outcomes?
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues questions:
• Have you discussed concurrent planning and alternative permanency resources (including parents) with
the parents? If “Yes,” the narrative for “Describe the parent’s response” pre-fills. If “No,” the narrative for
“Explain why concurrent planning and permanency resources, other than discharge to parents have not
been discussed with the parents” pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” you must record the response; it does not pre-fill.

4. Describe the concurrent plan or any other permanency discharge resource being considered for the
child, in the event the child is unlikely to be able to return home.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues questions:
• If the child has been in placement 3 months or more, have the foster parents been asked whether they
Date Printed 03/06/2007
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would consider adopting the child, should the child become free for adoption, or otherwise provide a
permanent living arrangement for the child? If “Yes,” the narrative for “Describe the foster parent’s
response” pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following FASP question:
• Has a permanency plan of guardianship/custody or adoption been discussed with the relative/resource? If
“Yes,” the narrative for “Describe the relative/resource’s response” pre-fills.

5. If there is a plan for trial discharge in the next six months, specify the anticipated date and explain why
such discharge is safe and appropriate.
Record
6. If there is a plan for final discharge in the next six months, specify the anticipated date and explain why
such discharge is safe and appropriate.
Record
7. If the permanency plan includes trial or final discharge from foster care, describe the Discharge Plan for
the child.
Living Arrangement (include location):
Record
Educational/Vocational Plan:
Record
Health Coverage:
Record
Follow-up Health/Mental Health Treatment Plan:
Record
Other:
Record
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SECTION III. REASONABLE EFFORTS TO FINALIZE PERMANENCY
8. Has there been a court determination that reasonable efforts to reunify the child with his or her
parent(s) are not required?
Select Yes
No
If Yes, for both parents, skip Question 9. If No, for one or both parents, answer Question 9.
9. For each parent for whom the answer to Question 8 is “No” and who has not had his or her parental
rights terminated or surrendered, describe the reasonable efforts that have been made since removal or
the last permanency hearing to enable the child to return home safely. The question must be answered
regardless of the child’s permanency planning goal.
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name
Name
(i.e., Mother, Father, Alleged Father
or Putative Father)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 10a, 10b and 10c pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Adoption.”

10. If the permanency planning goal is Adoption and the child is not completely legally free:
a. Describe the reasonable efforts to free the child, which shall include, but are not limited to,
information regarding the potential for a surrender, whether any surrender is complete and, if so,
whether it includes any terms or conditions; whether a Termination of Parental Rights proceeding has
been filed and if so, when; whether any diligent search has been completed on an absent parent,
including the methods and outcome.
The response is pre-filled and modifiable from the following Foster Care Issues questions:
• For a child in placement six months or more, have you discussed with the child’s parent(s) the signing of a
voluntary surrender, including, where appropriate, a conditional surrender? If “Yes,” the narrative for
“Describe the parent’s response” pre-fills.
• “TPR has been filed” or “TPR has not been filed,” as recorded for “Has a petition to terminate parental
rights been filed?”
• Have all parents been located? If “No,” the narrative for “Describe all efforts to locate them, including
results from inquiries to the Parent Locator Service” pre-fills.

b. Is the child placed in a pre-adoptive home? Select Yes

No

If No, describe efforts made to identify an adoptive resource.
The response is pre-filled and modifiable from the following Foster Care Issues question:
• Have you explored alternative permanency resources that may be available to the child should he or she
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be unable to return home. If” Yes,” the narrative for “Have any potential resources been identified? Who
are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been explored”
pre-fills.

c. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name

Service

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 11a, and 11b pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Guardianship or Placement with a Fit and Willing Relative.”

11. If the permanency goal is Guardianship or Placement with a Fit and Willing Relative:
a. Describe reasonable efforts made and services provided to finalize this plan. Specify the name and
relationship of the guardian or fit and willing relative.
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name
Name
Service
(i.e., Great Grandparent, Grandparent, (e.g., Drug Counseling/Treatment)
Aunt/Uncle, Cousin, Other family member
Or Niece/Nephew)

Status of service
(e.g., Provided Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

b. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name
Name
Service
(i.e., Great Grandparent, Grandparent, (e.g., Drug Counseling/Treatment)
Aunt/Uncle, Cousin, Other family member
Or Niece/Nephew)

Status of service
(e.g., Provided Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 12a, 12b and 12c pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Another Planned Permanency Living Arrangement.”
12. If the permanency goal is Another Planned Permanent Living Arrangement:
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a. Provide the compelling reason for determining that it would not be in the best interests of the child to
be returned home, placed for adoption, placed with a legal guardian, or placed with a fit and willing
relative.
The response is pre-filled and modifiable from the following narrative of the Tracked Children Detail window:
“Explain the reason for the PPG change and describe the reason(s) why it is not in the best interest of the
child to do any of the following: return to parent, place for adoption, refer for guardianship, or place with a
relative.”

b. Describe how this arrangement provides the child with a significant connection to an adult who is
willing to be a permanency resource for the child. Specify the arrangement and the name of the adult,
and describe reasonable efforts made and services provided to finalize this plan. If no adult has as yet
been identified, describe efforts made to identify a permanency resource.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues question:
• Have you explored alternative permanency resources that may be available to the child should he or she
be unable to return home. If” Yes,” the narrative for “Have any potential resources been identified? Who
are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been explored”
pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following Foster Care Issues question:
• Has a permanency plan of guardianship/custody or adoption been discussed with the relative/resource? If
“No,” the narrative for “Explain why the possibility of guardianship/custody or adoption has not been
discussed” pre-fills.

c. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following information:
Child’s Name
Name
(i.e., Unrelated household member,
Other or None)

Service
(e.g., Drug Counseling/Treatment)

13. Is the child AWOL? Select Yes

Status of service
(e.g., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

No

If Yes, describe efforts to locate the child.
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SECTION IV. CHILD’S PLACEMENT(S)

14.
Child’s
Name

Pre-filled,
not
modifiable

Physical
Removal Date

Number of Changes in
Placement Since Removal
or Previous Permanency
Hearing

Child Currently Placed

Modifiable; prefilled from the
Removal
Information tab.

Record

Select

Foster Boarding Home
Non-relative
Relative
Congregate Care Facility
Relative (Direct Placement)
Other

15. Provide current information regarding the placement of the child including: the name of the person(s)
with whom the child is placed, if applicable; changes in the placement setting; protecting factors in the
current home/facility that support the child’s safety, and how this setting supports the least restrictive,
most appropriate placement that addresses the needs of the child.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Tracked Children Detail window areas:
• Agency Name or Name of Discharge Resource
• Adjustment and Functioning narrative: “For each child in foster care, describe the child’s response to
separation and loss and the child’s functioning and overall well-being in their current placement. Also
explain how this placement is the most appropriate setting to meet the child’s current service and health
needs and whether it is the least restrictive and most home like setting required to support eh child’s wellbeing; if appropriate, include a description of the child’s response to any moves from one foster care
setting to another.”
• Safety in Foster Care narrative: “Identify and describe protecting factors that keep the child safe in this
placement.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following areas:
• Tracked Children Detail window – “Agency Name: <Name of Agency>” or “Name of Discharge Resource:
<Resource Name>”
• Foster Care Issues – Appropriateness of Alternative Setting – “Caretaker Name: <Name of Caretaker>”
and “Relationship to Caretaker: <Relationship>”
• Foster Care Issues – Placement Functioning narratives: “For each child in an alternative setting, describe
the child’s functioning. The pertinent information to be included is: the child’s adjustment in the current
placement; how this setting meets the child’s needs” and “Identify and describe the key protecting factors
that keep the child safe in this setting.”

16. Is the child placed out of state? Yes

No

Pre-filled and modifiable
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If Yes, explain why it is appropriate, necessary and in the best interests of the child?

For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues question:
• Is the child placed a substantial distance from his/her parents? If” Yes,” the narrative for “Explain why such
a placement is in the best interest of the child” pre-fills. If “No,” the narrative for “Explain why permanency
resources have not been explored” pre-fills.
If the child’s Program Choice is “Non-LDSS Custody,” you must record a response; it does not pre-fill.
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SECTION V. PARENT STATUS AND SERVICES PROVIDED
17. For parent(s) or legally responsible person(s):
a. Describe services offered and/or provided to each parent/person legally responsible since removal or
the last permanency hearing.

A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Mother, Father, Alleged Father
or Putative Father, Adoptive Mother,
Adoptive Father, Legal Guardian or
Legal Custodian)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

b. Describe the efforts made by each parent/person legally responsible to engage in the services, the
progress made towards reunification, and any other efforts made by each parent/person legally
responsible to achieve the permanency plan.

For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues narrative:
“Describe the positive progress made to achieve the permanency goal. Describe the parent’s, relative’s or
primary resource person’s involvement in planning for the child’s discharge. Specify any barriers to timely
permanency.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following areas of Foster Care Issues:
• Narrative: “Explain if the plan is to reunite child(ren) with parent or for children to remain in care of
relative/resource.”
• Is parent(s) in agreement with this plan? If “Yes,” “Parents in agreement with plan” pre-fills. If “No,”
“Parents not in agreement with plan” pre-fills. If “N/A,” “This question does not apply” pre-fills. If “No,” the
“Explain” narrative pre-fills.

c. Describe any barriers to service provision.

For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues Progress Towards Permanency narrative:
“Describe the positive progress made to achieve the permanency goal. Describe the parent’s, relative’s or
primary resource person’s involvement in planning for the child’s discharge. Specify any barriers to timely
permanency.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
Date Printed 03/06/2007

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

following areas of Foster Care Issues:
• Narrative: “Explain if the plan is to reunite child(ren) with parent or for children to remain in care of
relative/resource.”
• Is parent(s) in agreement with this plan? If “Yes,” “Parents in agreement with plan” pre-fills. If “No,”
“Parents not in agreement with plan” pre-fills. If “N/A,” “This question does not apply” pre-fills. If “No,” the
“Explain” narrative pre-fills.

d. Describe any additional services anticipated in the next six months.

A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Mother, Father, Alleged Father
or Putative Father, Adoptive Mother,
Adoptive Father, Legal Guardian or
Legal Custodian)

Service
(e.g., Drug Counseling/Treatment)
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SECTION VI. VISITING
18. Visiting plan
This modifiable section pre-fills with active visitation plans recorded in Foster Care Issues. The following
information displays:
• Review Status
• Plan Description
• Primary Location
• Frequency
• Duration
• Visiting Plan Status
• Children
• Adults
• Other Participants
• Response to “Are there any special conditions (i.e., court orders, supervised visitation, phone
contacts, mail) regarding visitation?”
• Response to “Explain the condition. For supervised visitation, explain the reason and how
supervision will be provided”
• Response to “Is assistance necessary to facilitate visitation?”
• Response to “Describe specifically what will occur during visits to enhance parental capability,
support the parent/child relationship and support the child’s well-being”
• Response to “Provide any additional detail regarding location, frequency, or duration of the visiting
plan”
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SECTION VII. SERVICES PROVIDED TO CHILD
19. Describe all services offered and/or provided to the child since removal or the last permanency hearing
and the outcomes or progress the child has made.

A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name

Service

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Describe any additional services for the child anticipated in the next six months.

Record

20. If the child is age 14 or older, describe the Independent Living Skills Services provided to the child since
removal or the last permanency hearing and the skills attained.

Record

Describe any additional Independent Living Skills Services anticipated for the child in the next six
months.

Record

Date Printed 03/06/2007

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

SECTION VIII. CHILD’S HEALTH AND WELL- BEING
21. If applicable, note the following for the child:
Significant Chronic Conditions:
The response is modifiable and pre-filled with:
• all non-end-dated and valid diagnoses for the child recorded on the Health Services Clinical
Appointment tab where the domain is Dental, Physical/Medical, or Substance Abuse, except “HIV
Infection” or “Dementia Due to HIV Infection”; and
• all non-end-dated and valid allergies recorded on the Health Services Child Health Info. tab where
the domain is Dental, Physical/Medical, or Substance Abuse.

Significant Developmental Delay:
The response is modifiable and pre-filled with all non-end-dated and valid diagnoses for the child recorded on
the Health Services Clinical Appointment tab where the domain is Developmental, except “HIV Infection” or
“Dementia Due to HIV Infection.”

Mental Health Diagnoses:
The response is modifiable and pre-filled with all non-end-dated and valid diagnoses for the child recorded on
the Health Services Clinical Appointment tab where the domain is Mental Health, except “HIV Infection” or
“Dementia Due to HIV Infection.”

Serious Injuries/Hospitalization:
The response is modifiable and pre-filled with all valid hospitalizations for the child recorded on the Health
Services Child Health Info. tab, including Hospital Name, Start Date and End Date; the reason for
hospitalization does not pre-fill.

Current Medication:
The response is modifiable and pre-filled with all non-end-dated and valid medications for the child recorded on
the Health Services Child Health Info. Tab.

22. Describe any other significant information about the child’s current health and well-being not included
above.

Record

Date of Last
Physical

Date of Last
Mental Health
Appointment,

Date of Last
Dental
Appointment

Date of Last
Vision
Screening
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The response is
modifiable and
pre-filled with the
most current,
valid
appointment date
recorded on the
Health Services
Clinical
Appointment
tab where the
Appointment
Type is “Well
Child” and the
Domain is
Physical/Medical.

The response is
modifiable and
pre-filled with the
most current,
valid
appointment date
recorded on the
Health Services
Clinical
Appointment
tab where the
Appointment
Type is “Mental
Health.”

The response
is modifiable
and pre-filled
with the most
current, valid
appointment
date recorded
on the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is
“Dental.”

Record

Record

Yes

No

Select

23. Describe any follow-up treatment or recommendations for the child, as a result of the above
appointments/screenings.

The response is modifiable and pre-filled with a list of all non-end-dated and valid diagnoses for the child
recorded on the Health Services Clinical Appointment tab, except “HIV Infection” or “Dementia Due to HIV
Infection,” including associated treatment recommendations.
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SECTION IX. CHILD’S EDUCATION
24. Provide information on the child’s current grade level or program, academic progress and achievements,
and any other relevant educational information.

The response is modifiable and pre-filled with the following information:
• “Academic Grade Level: <Grade Level>” for the current academic year and the most current Effective
Date, as recorded on the Education window; and
• from the Strengths, Needs and Risks Child Scales, “Academic Performance: <Response>.”

25. Describe the steps the agency will take during the next six months to enable prompt delivery of
appropriate educational and/or vocational services to the child in his or her current placement, or in any
proposed placement(if applicable), or while on trial or at final discharge.

Record

26. Complete the sections appropriate to the age-level and educational status of the child.
a. If the child is under age 3, check which, if any, of the following criteria the child meets:
involved in an indicated case of child abuse or maltreatment Modifiable and
pre-filled if child had any role in any Indicated investigation(s).
suspected to have a disability Modifiable and pre-filled when “Disability” is
selected as the Classification/Disability Type on the Early Intervention tab.
has been found eligible for Early Intervention Services (EI) Modifiable and prefilled when “Disability” or “Developmental Delay” is selected as the
Classification/Disability Type on the Early Intervention tab.
If one or more criteria are met, check the appropriate boxes.
Referral Date

Receiving
Services

Not Eligible

This response is
modifiable and prefilled from the
Early Intervention
tab.

Modifiable and
pre-filled if any
service type is
being received.

Select this
box if there are
no boxes
selected in 26a.
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Describe the steps taken to refer the child to Early Intervention Services, the status of the
referral and any services the child is receiving. If the child listed above has not yet been referred,
explain why.

The response is modifiable and pre-filled with:
• a list of all non-end-dated and valid services on the Early Intervention tab that have a status of
“Received” or “Anticipated”;
• “Date of Referral <MM/DD/YYYY>”;
• “Date of Evaluation <MM/DD/YYYY>”; and
• Classification/Disability Type: “Disability,” “Developmental Delay” or “None.”

b. If the child is eligible for Pre-Kindergarten (turns age 4 before December 1st), check the
appropriate boxes. Select
Pre-K Not
Available

Pre-K
Available

Not Enrolled

Enrolled

If Pre-kindergarten is available and the child is NOT enrolled, describe steps taken to enroll the
child.

Record

c. If the child is age three or older and is suspected of having a disability or has been found eligible
for Special Education prior to or during foster care, describe the status of the referral, the
Individualized Education Program (IEP) related recommendations and services provided by the
school.

If an IEP exists for the current academic year, the response is modifiable and pre-filled with the following
information:
• “IEP Date - <MM/DD/YYYY>”, as recorded on the Education Detail window;
• a list of services, as recorded on the IEP Detail window; and
• a list of related services, as recorded on the IEP Detail window.

d. If the child is school age (ages 6-16/17, depending on locality) or elects to participate in a program
leading to a high school diploma, describe the steps taken to enroll the child in a program or
continue in a program leading to a high school diploma.

Record

Date Printed 03/06/2007

Page X of X

PH-1 Individual Child

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

e. If the child is over age 16/17 (depending on locality), and the child has elected not to participate
in a high school diploma program, describe the steps taken to assist the child to become employed
and/or to become enrolled in an appropriate vocational program.

Record
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VERIFICATION

STATE OF NEW YORK, COUNTY OF SP
Record, BEING DULY SWORN, DEPOSES AND SAYS:
that I am employed at Record, as a caseworker;
that I have (written

read

) the foregoing permanency report and know the contents thereof;

that the information is true and complete to my own knowledge, or believed to be true based upon information
derived from official records and/or reports kept in the regular course of business by this social services district or
voluntary authorized agency directly involved in assessment and/or service provision to the individuals that are the
subject(s) of this report;
that this report is a true and complete copy of the report that was mailed to the parties 14 days prior to the date
certain of the permanency hearing.

Name: ____________________________
Title: _____________________________

Sworn to before me this
_______day of ________

____________________
Notary Public

___________________
Commissioner of Deeds
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Fields with an * populate when the “No Pre-fill” option is selected.

PERMANENCY HEARING DATE CERTAIN: Pre-filled, not modifiable

Judge / Referee

Court

Part

Record

Record

Record

IN THE MATTER OF:
Child’s Name
Date of Birth
* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

Sex
* Pre-filled,

Person ID (PID)
* Pre-filled, not

not
modifiable

modifiable

* Pre-filled,

* Pre-filled, not

not
modifiable

modifiable

Docket Number
Record

Record

DATE OF REPORT PREPARATION: E

All information must be current and represent an update of events and circumstances since removal or the
previous Permanency Hearing
Case Name:

* Pre-filled, not
modifiable

Law Guardian:

Record

CONNECTIONS
Case ID:

* Pre-filled, not
modifiable

Record

Local Case #:

Record

Attorney for Parent(s) or
Person(s) Legally
Responsible:
Attorney for DSS/ACS:

Case Manager

* Pre-filled, not
modifiable

Phone:

* Pre-filled, modifiable

Case Planner

* Pre-filled, not
modifiable

Phone:

* Pre-filled, modifiable

Agency with
Planning
Responsibility:
Associate
Caseworker(s)
Child Protective

* Pre-filled, not
modifiable
Record

Phone:

Record

* Pre-filled, not
modifiable

Phone:

* Pre-filled, modifiable
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Worker/Monitor
PARENTS AND PERSONS LEGALLY RESPONSIBLE

Name

Relationship

Associated Children

* Pre-filled, not modifiable

* Pre-filled, not modifiable

Record

Individuals with the following
relationships display:
• Mother
• Father
• Alleged Father
• Putative Father
• Adoptive Mother
• Adoptive Father
• Legal Guardian
• Legal Custodian
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SECTION I. PERMANENCY PLAN SUMMARY - Complete for all children
Child’s Name

Current Permanency
Planning Goal (PPG)

PPG/Date
Established

Anticipated PPG

* Pre-filled, not
modifiable

* Pre-filled, not modifiable

* Pre-filled, not
modifiable

Select

Return to parent(s)
Placement for adoption
Referral for legal guardianship
Permanent placement with fit
and willing relative
Placement in another planned
permanent living arrangement
with significant connection to an
adult
For children with a Program Choice
of “Placement,” the above options
display.
For children with a Program Choice
of “Non-LDSS Custody,” the
following Anticipated PPG’s display:
1. Reunite with Parent
2. Legalize Living Arrangement
with Relative/Resource
3. Permanent Living
Arrangement (NonGuardianship/NonCustodian)

Return to parent(s)
Placement for adoption
Referral for legal guardianship
Permanent placement with fit
and willing relative
Placement in another planned
permanent living arrangement
with significant connection to an
adult

Date by which it is expected that the current or anticipated PPG will be accomplished:
Child’s Name

Date

Pre-filled, not modifiable

Record
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SECTION II. PERMANENCY PLANNING
1. If there is a plan for continuing placement for any of the children, specify the child and describe the
reason placement continues to be necessary and in accordance with the best interests and safety of the
child, including whether the child would be at risk of abuse or neglect if returned to the parent or other
person legally responsible.
Record

2. If there is a plan for continuing placement for any of the children, describe the efforts made since
removal or the last permanency hearing, if any, to locate any absent parent or relative(s) of the children
and to notify each of them of the children’s placement in foster care.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable based on the
following Foster Care Issues questions:
• Have all parents been identified? If “No,” the narrative for “Describe the efforts to identify them” pre-fills.
• Have all parents been located? If “No,” the narrative for “Describe all efforts to locate them, including
results from inquiries to the Parent Locator Service” pre-fills.
• Have you explored alternative permanency resources that may be available to the child should he or she
be unable to return home? If “Yes,” the narrative for “Have any potential resources been identified? Who
are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been explore?”
pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” you must record the response; it does not pre-fill.

3. State whether the absent parent or relative expressed an interest in obtaining custody of or planning for
any of the children, or whether any relative is interested in becoming a foster parent for any of the
children. If interest has been expressed, what has been done to further any of these outcomes?
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues questions:
• Have you discussed concurrent planning and alternative permanency resources (including parents) with
the parents? If “Yes,” the narrative for “Describe the parent’s response” pre-fills. If “No,” the narrative for
“Explain why concurrent planning and permanency resources, other than discharge to parents have not
been discussed with the parents” pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” you must record the response; it does not pre-fill.

4. Describe the concurrent plan or any other permanency discharge resource being considered for each
child, in the event that any of the children are unlikely to be able to return home.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues questions:
• If the child has been in placement 3 months or more, have the foster parents been asked whether they
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would consider adopting the child, should the child become free for adoption, or otherwise provide a
permanent living arrangement for the child? If “Yes,” the narrative for “Describe the foster parent’s
response” pre-fills.

For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following FASP question:
• Has a permanency plan of guardianship/custody or adoption been discussed with the
relative/resource? If “Yes,” the narrative for “Describe the relative/resource’s response” pre-fills.

5. If there is a plan for trial discharge in the next six months, specify the child, the anticipated date and
explain why such discharge is safe and appropriate.
Record

6. If there is a plan for final discharge in the next six months, specify the child, the anticipated date and
explain why such discharge is safe and appropriate.

Record

7. If the permanency plan includes trial or final discharge from foster care, describe the Discharge Plan for
the children.
Living Arrangement (include location):
Record

Educational/Vocational Plan:
Record

Health Coverage:
Record

Follow-up Health/Mental Health Treatment Plan:
Record

Other:
Record
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SECTION III. REASONABLE EFFORTS TO FINALIZE PERMANENCY
8. Has there been a court determination that reasonable efforts to reunify the children with their parent(s)
are not required?
Select
Yes
No
If Yes, for both parents, skip Question 9. If No, for one or both parents, answer Question 9.

9. For each parent for whom the answer to Question 8 is “No” and who has not had his or her parental
rights terminated or surrendered, describe the reasonable efforts that have been made since removal or
the last permanency hearing to enable the children to return home safely. The question must be
answered regardless of the children’s permanency planning goal.
A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Child, Mother, Father, Alleged Father
or Putative Father)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 10a, 10b and 10c pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Adoption.”

10. If the permanency planning goal is Adoption and the children are not completely legally free:
a. Describe the reasonable efforts to free the children, which shall include, but are not limited to,
information regarding the potential for a surrender, whether any surrender is complete and, if so,
whether it includes any terms or conditions; whether a Termination of Parental Rights proceeding has
been filed and if so, when; whether any diligent search has been completed on an absent parent,
including the methods and outcome.
The response is pre-filled and modifiable from the following Foster Care Issues questions:
• For a child in placement six months or more, have you discussed with the child’s parent(s) the signing of a
voluntary surrender, including, where appropriate, a conditional surrender? If “Yes,” the narrative for
“Describe the parent’s response” pre-fills.
• “TPR has been filed” or “TPR has not been filed,” as recorded for “Has a petition to terminate parental
rights been filed?”
• Have all parents been located? If “No,” the narrative for “Describe all efforts to locate them, including
results from inquiries to the Parent Locator Service” pre-fills.

b. Are the children placed in a pre-adoptive home? Select

Yes

No

If No, describe efforts made to identify an adoptive resource.
The response is pre-filled and modifiable from the following Foster Care Issues question:
• Have you explored alternative permanency resources that may be available to the child should he or she
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be unable to return home. If” Yes,” the narrative for “Have any potential resources been identified? Who
are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been explored”
pre-fills.

c. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name

Service

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 11a, and 11b pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Guardianship or Placement with a Fit and Willing Relative.”

11. If the permanency goal is Guardianship or Placement with a Fit and Willing Relative:
a. Describe reasonable efforts made and services provided to finalize this plan. Specify the name and
relationship of the guardian or fit and willing relative.
A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Child, Great Grandparent, Grandparent,
Aunt/Uncle, Cousin, Other family member
Or Niece/Nephew)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(e.g., Provided Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

b. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Child, Great Grandparent, Grandparent,
Aunt/Uncle, Cousin, Other family member
Or Niece/Nephew)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(e.g., Provided Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Questions 12a, 12b and 12c pre-fill only for children in an FSS/CWS stage with a Permanency Planning Goal of
“Another Planned Permanency Living Arrangement.”
12. If the permanency goal is Another Planned Permanent Living Arrangement:
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a. Provide the compelling reason for determining that it would not be in the best interests of the children
to be returned home, placed for adoption, placed with a legal guardian, or placed with a fit and willing
relative.
The response is pre-filled and modifiable from the following narrative of the Tracked Children Detail window:
“Explain the reason for the PPG change and describe the reason(s) why it is not in the best interest of the
child to do any of the following: return to parent, place for adoption, refer for guardianship, or place with a
relative.”

b. Describe how this arrangement provides the children with a significant connection to an adult who is
willing to be a permanency resource for the children. Specify the arrangement and the name of the
adult, and describe reasonable efforts made and services provided to finalize this plan. If no adult has as
yet been identified, describe efforts made to identify a permanency resource.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues question:
• Have you explored alternative permanency resources that may be available to the child should he or
she be unable to return home. If” Yes,” the narrative for “Have any potential resources been identified?
Who are they?” pre-fills. If “No,” the narrative for “Explain why permanency resources have not been
explored” pre-fills.
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following Foster Care Issues question:
• Has a permanency plan of guardianship/custody or adoption been discussed with the
relative/resource? If “No,” the narrative for “Explain why the possibility of guardianship/custody or
adoption has not been discussed” pre-fills.

•
c. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following information:
Name
(i.e., Child, Unrelated household member,
Other or None)

13. Is any child AWOL?

Select

Yes

Service
(e.g., Drug Counseling/Treatment)

Status of service
(e.g., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

No

If Yes, identify the child(ren) and describe efforts to locate the child(ren).
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SECTION IV. CHILD’S PLACEMENT(S)

14.
Child’s
Name

Pre-filled,
not
modifiable

Physical
Removal Date

# of Changes in Placement
Since Removal or
Previous Permanency
Hearing

Child Currently Placed

Modifiable; prefilled from the
Removal
Information tab.

Record

Select

Foster Boarding Home
Non-relative
Relative
Congregate Care Facility
Relative (Direct Placement)
Other
Foster Boarding Home
Non-relative
Relative
Congregate Care Facility
Relative (Direct Placement)
Other

15. Provide current information regarding the placement of each child including: the name of the person(s)
with whom each child is placed, if applicable; changes in the placement setting; protecting factors in the
current home/facility that support the children’s safety, and how this setting supports the least
restrictive, most appropriate placement that addresses the needs of the children.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Tracked Children Detail window areas:
• Agency Name or Name of Discharge Resource
• Adjustment and Functioning narrative: “For each child in foster care, describe the child’s response to
separation and loss and the child’s functioning and overall well-being in their current placement. Also
explain how this placement is the most appropriate setting to meet the child’s current service and health
needs and whether it is the least restrictive and most home like setting required to support eh child’s wellbeing; if appropriate, include a description of the child’s response to any moves from one foster care
setting to another.”
• Safety in Foster Care narrative: “Identify and describe protecting factors that keep the child safe in this
placement.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following areas:
• Tracked Children Detail window – “Agency Name: <Name of Agency>” or “Name of Discharge Resource:
<Resource Name>”
• Foster Care Issues – Appropriateness of Alternative Setting – “Caretaker Name: <Name of Caretaker>”
and “Relationship to Caretaker: <Relationship>”
• Foster Care Issues – Placement Functioning narratives: “For each child in an alternative setting, describe
the child’s functioning. The pertinent information to be included is: the child’s adjustment in the current
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placement; how this setting meets the child’s needs” and “Identify and describe the key protecting factors
that keep the child safe in this setting.”

16. Is any child placed out of state? Yes

No

Pre-filled and modifiable

If Yes, explain why it is appropriate, necessary and in the best interests of the child?

For children with a Program Choice of “Placement,” the response is modifiable and pre-filled from the following
Foster Care Issues question:
• Is the child placed a substantial distance from his/her parents? If” Yes,” the narrative for “Explain why such
a placement is in the best interest of the child” pre-fills. If “No,” the narrative for “Explain why permanency
resources have not been explored” pre-fills.
If the child’s Program Choice is “Non-LDSS Custody,” you must record a response; it does not pre-fill.
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SECTION V. PARENT STATUS AND SERVICES PROVIDED
17. For parent(s) or legally responsible person(s):
a. Describe services offered and/or provided to each parent/person legally responsible since removal or
the last permanency hearing.

A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Mother, Father, Alleged Father
or Putative Father, Adoptive Mother,
Adoptive Father, Legal Guardian or
Legal Custodian)

Service
(e.g., Drug Counseling/Treatment)

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

b. Describe the efforts made by each parent/person legally responsible to engage in the services, the
progress made towards reunification, and any other efforts made by each parent/person legally
responsible to achieve the permanency plan.

For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues narrative:
“Describe the positive progress made to achieve the permanency goal. Describe the parent’s, relative’s or
primary resource person’s involvement in planning for the child’s discharge. Specify any barriers to timely
permanency.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
following areas of Foster Care Issues:
• Narrative: “Explain if the plan is to reunite child(ren) with parent or for children to remain in care of
relative/resource.”
• Is parent(s) in agreement with this plan? If “Yes,” “Parents in agreement with plan” pre-fills. If “No,”
“Parents not in agreement with plan” pre-fills. If “N/A,” “This question does not apply” pre-fills. If “No,” the
“Explain” narrative pre-fills.

c. Describe any barriers to service provision.

For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
Foster Care Issues Progress Towards Permanency narrative:
“Describe the positive progress made to achieve the permanency goal. Describe the parent’s, relative’s or
primary resource person’s involvement in planning for the child’s discharge. Specify any barriers to timely
permanency.”
For children with a Program Choice of “Non-LDSS Custody,” the response is pre-filled and modifiable from the
Date Printed 03/06/2007

Page X of X

PH-2 Multiple Children

PERMANENCY HEARING REPORT
****WARNING****
CONFIDENTIAL INFORMATION
AUTHORIZED PERSONNEL ONLY

DRAFT

Docket #

Case #

following areas of Foster Care Issues:
• Narrative: “Explain if the plan is to reunite child(ren) with parent or for children to remain in care of
relative/resource.”
• Is parent(s) in agreement with this plan? If “Yes,” “Parents in agreement with plan” pre-fills. If “No,”
“Parents not in agreement with plan” pre-fills. If “N/A,” “This question does not apply” pre-fills. If “No,” the
“Explain” narrative pre-fills.

d. Describe any additional services anticipated in the next six months.

A pre-filled and modifiable list displays with the following Service Plan information:
Name
(i.e., Mother, Father, Alleged Father
or Putative Father, Adoptive Mother,
Adoptive Father, Legal Guardian or
Legal Custodian)

Service
(e.g., Drug Counseling/Treatment)
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SECTION VI. VISITING
18. Visitation Plan

This modifiable section pre-fills with active visitation plans recorded in Foster Care Issues where the child(ren)
is in the Child Participant List. The following visiting plan information displays:
• Review Status
• Plan Description
• Primary Location
• Frequency
• Duration
• Visiting Plan Status
• Children
• Adults
• Other Participants
• Response to “Are there any special conditions (i.e., court orders, supervised visitation, phone
contacts, mail) regarding visitation?”
• Response to “Explain the condition. For supervised visitation, explain the reason and how
supervision will be provided”
• Response to “Is assistance necessary to facilitate visitation?”
• Response to “Describe specifically what will occur during visits to enhance parental capability,
support the parent/child relationship and support the child’s well-being”
• Response to “Provide any additional detail regarding location, frequency, or duration of the visiting
plan”
If no plan exists for a child, the “No Visiting Plan” narrative will pre-fill for that child.
For children with a Program Choice of “Non-LDSS Custody,” pre-filled and modifiable information displays
based on the following question in Foster Care Issues:
• Does the child have contact with member of his/her family? If “Yes,” the narrative for “Describe the
contact” pre-fills.
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SECTION VII. SERVICES PROVIDED TO CHILD
19. Describe all services offered and/or provided to each child since removal or the last permanency hearing
and the outcomes or progress each child has made.

Name

Services

Pre-filled and
modifiable

A pre-filled and modifiable list of services and their statuses displays.

Describe any additional services for each child anticipated in the next six months.

Name

Additional Services

Record

Record

20. If the child is age 14 or older, describe the Independent Living Skills Services provided to each child
since removal or the last permanency hearing and the skills attained.

Name

Independent Living Skills

Record

Record

Describe any additional Independent Living Skills Services anticipated for each child in the next six
months.

Name

Addition Independent Living Skills

Record

Record
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SECTION VIII. CHILD’S HEALTH AND WELL- BEING
21. If applicable, note the following for each child:
Significant Chronic Conditions:

Name

Significant Chronic Conditions

Pre-filled and
modifiable

The response is modifiable and pre-filled for each child with:
• all non-end-dated and valid diagnoses recorded on the Health
Services Clinical Appointment tab where the domain is Dental,
Physical/Medical, or Substance Abuse, except “HIV Infection” or
“Dementia Due to HIV Infection”; and
• all non-end-dated and valid allergies recorded on the Health Services
Child Health Info. tab where the domain is Dental, Physical/Medical,
or Substance Abuse.

Significant Developmental Delay and Medications:
Significant Developmental Delay
Name
Pre-filled and
modifiable

The response is modifiable and pre-filled for each child with all non-end-dated and
valid diagnoses recorded on the Health Services Clinical Appointment tab where
the domain is Developmental, except “HIV Infection” or “Dementia Due to HIV
Infection.”

Mental Health Diagnoses:

Name

Mental Health Diagnoses

Pre-filled and
modifiable

The response is modifiable and pre-filled for each child with all non-end-dated and
valid diagnoses recorded on the Health Services Clinical Appointment tab where
the domain is Mental Health, except “HIV Infection” or “Dementia Due to HIV
Infection.”

Serious Injuries/Hospitalization:

Name

Serious Injuries/Hospitalization

Pre-filled and
modifiable

The response is modifiable and pre-filled for each child with all valid
hospitalizations recorded on the Health Services Child Health Info. tab,
including Hospital Name, Start Date and End Date; the reason for hospitalization
does not pre-fill.
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Current Medication:

Name

Current Medication

Pre-filled and
modifiable

The response is modifiable and pre-filled for each child with all non-end-dated
and valid medications recorded on the Health Services Child Health Info. tab.

22. Describe any other significant information about the child’s current health and well-being not included
above.

Record

Child’s
Name

Date of Last
Physical

Date of Last
Date of Last
Dental
Mental
Appointment
Health
Appointment,
if applicable

Date of
Last
Vision
Screening

Date of
Last
Hearing
Screening

Immunizations
Up-To-Date

Pre-filled
and
modifiable

The response is
modifiable and
pre-filled for
each child with
the most current,
valid
appointment
date recorded on
the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is “Well
Child” and the
Domain is
Physical/Medical

The response
is modifiable
and pre-filled
for each child
with the most
current, valid
appointment
date recorded
on the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is
“Mental
Health”.

Record

Record

Yes

The response
is modifiable
and pre-filled
with the most
current, valid
appointment
date recorded
on the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is
“Dental.”

Yes
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23. Describe any follow-up treatment or recommendations for the child, as a result of the above
appointments/screenings.

The response is modifiable and pre-filled with a list of all non-end-dated and valid diagnoses recorded on the
Health Services Clinical Appointment tab for each child, except “HIV Infection” or “Dementia Due to HIV
Infection,” including associated treatment recommendations.
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SECTION IX. CHILD’S EDUCATION
24. Provide information on each child’s current grade level or program, academic progress and
achievements, and any other relevant educational information.

Name

Current Program

Pre-filled and
modifiable

The response is modifiable and pre-filled with the following information for each
child:
• “Academic Grade Level: <Grade Level>” for the current academic year and
the most current Effective Date, as recorded on the Education window; and
• from the Strengths, Needs and Risks Child Scales, “Academic Performance:
<Response>.”

25. Describe the steps the agency will take during the next six months to enable prompt delivery of
appropriate educational and/or vocational services to each child in his or her current placement, or in
any proposed placement (if applicable), or while on trial or at final discharge.

Name

Future Steps

Pre-filled and
modifiable

Record
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26. Complete the sections appropriate to the age-level and educational status of the child.
a. If the child is under age 3, check which, if any, of the following criteria the child meets:
Childs Name
Pre-filled and
modifiable

Criteria
involved in an indicated case of child abuse or maltreatment Modifiable and prefilled if child had any role in any Indicated investigation(s).
suspected to have a disability Modifiable and pre-filled when “Disability” is selected
as the Classification/Disability Type on the Early Intervention tab.
has been found eligible for Early Intervention Services (EI) Modifiable and prefilled when “Disability” or “Developmental Delay” is selected as the
Classification/Disability Type on the Early Intervention tab.

involved in an indicated case of child abuse or maltreatment
suspected to have a disability
has been found eligible for Early Intervention Services (EI)
If one or more criteria are met, check the appropriate boxes.
Child’s Name

Referral Date

Receiving
Services

Not Eligible

Pre-filled and
modifiable

This response is
modifiable and
pre-filled from the
Early
Intervention tab.

Modifiable
and pre-filled if
any service type
is being received.

if no boxes
from 26a are
checked, check
this box
if no boxes
from 26a are
checked, check
this box

Describe the steps taken to refer the child to Early Intervention Services, the status of the
referral and any services the child is receiving. If the child listed above has not yet been referred,
explain why.
Child’s Name

Steps

Pre-filled and
modifiable

The response is modifiable and pre-filled with:
• a list of all non-end-dated and valid services on the Early Intervention tab
that have a status of “Received”;
• “Date of Referral <MM/DD/YYYY>”;
• “Date of Evaluation <MM/DD/YYYY>”; and
• Classification/Disability Type: “Disability,” “Developmental Delay” or “None.”
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b. If the child is eligible for Pre-Kindergarten (turns age 4 before December 1st), check the
appropriate boxes. Select

Child’s Name

Pre-K Not
Available

Pre-K
Available

Not Enrolled

Enrolled

Pre-filled and
modifiable

If Pre-kindergarten is available and the child is NOT enrolled, describe steps taken to enroll the
child.
Child’s Name

Steps

Pre-filled and
modifiable

Record

c. If any child is age three or older and is suspected of having a disability or has been found eligible
for Special Education prior to or during foster care, describe the status of the referral, the
Individualized Education Program (IEP) related recommendations and services provided by the
school.
Child’s Name

Status

Pre-filled and
modifiable

If an IEP exists for the current academic year, the response is modifiable and prefilled with the following information:
• “IEP Date - <MM/DD/YYYY>”, as recorded on the Education Detail window;
• a list of services, as recorded on the IEP Detail window; and
• a list of related services, as recorded on the IEP Detail window.

d. If any child is school age (ages 6-16/17, depending on locality) or elects to participate in a
program leading to a high school diploma, describe the steps taken to enroll the child in a
program or continue in a program leading to a high school diploma.
Child’s Name

Program

Pre-filled and
modifiable

Record
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e. If any child is over age 16/17 (depending on locality), and the child has elected NOT to participate
in a high school diploma program, describe the steps taken to assist the child to become employed
and/or to become enrolled in an appropriate vocational program.
Child’s Name

Program

Pre-filled and
modifiable

Record
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VERIFICATION

STATE OF NEW YORK, COUNTY OF

Pre-filled and not modifiable

Record, BEING DULY SWORN, DEPOSES AND SAYS:

that I am employed at Record, as a caseworker;
that I have (written

read

) the foregoing permanency report and know the contents thereof;

that the information is true and complete to my own knowledge, or believed to be true based upon information
derived from official records and/or reports kept in the regular course of business by this social services district or
voluntary authorized agency directly involved in assessment and/or service provision to the individuals that are the
subject(s) of this report;
that this report is a true and complete copy of the report that was mailed to the parties 14 days prior to the date
certain of the permanency hearing.

Name: ____________________________ (Null)
Title: _____________________________(Null)

Sworn to before me this
_______day of ________ (Null)

____________________(Null)
Notary Public

___________________(Null)
Commissioner of Deeds
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Fields with an * populate when the “No Pre-fill” option is selected.

PERMANENCY HEARING DATE CERTAIN: Pre-filled, not modifiable

Judge / Referee

Court

Part

Record

Record

Record

IN THE MATTER OF:
Child’s Name
Date of Birth
* Pre-filled, not
modifiable

* Pre-filled, not
modifiable

Sex

Person ID (PID)

* Pre-filled,
not
modifiable

* Pre-filled, not
modifiable

Docket Number
Docket Number(s)
under which child was
freed (if different):
Mother
Father

Record
Record

DATE OF REPORT PREPARATION: E
All information must be current and represent an update of events and circumstances since the child was
freed for adoption or the previous Permanency Hearing
Case Name:
CONNECTIONS
Case ID:
Local Case #:
Case Manager
Case Planner:
Agency with
Planning
Responsibility:
Associated Case
Worker:

* Pre-filled, not
modifiable
* Pre-filled, not
modifiable
Record
* Pre-filled, not
modifiable
* Pre-filled, not
modifiable
* Pre-filled, not
modifiable

Law Guardian:

Record

Attorney for DSS/ACS:

Record

Phone:

* Pre-filled, modifiable

Phone:

* Pre-filled, modifiable

Record

Phone:

Record

SECTION I. PERMANENCY PLAN SUMMARY
Child’s Name

Current Permanency
Planning Goal (PPG)

PPG/Date
Established

Anticipated PPG

* Pre-filled, not
modifiable

* Pre-filled, not modifiable

* Pre-filled, not
modifiable

Select

Placement for adoption
Referral for legal guardianship
Permanent placement with fit
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and willing relative
Placement in another planned
permanent living arrangement
with significant connection to an
adult

Date by which it is expected that the current or anticipated PPG will be accomplished: Record
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SECTION II. PERMANENCY PLANNING
1. If there is a plan for continuing placement for the child, describe the reason placement continues to be
necessary and in accordance with the best interests and safety of the child.
Record

2. If there is a plan for trial or final discharge in the next six months, specify the anticipated date and
explain why such discharge is safe and appropriate.
Record

3. If the permanency plan includes trial or final discharge from foster care, describe the Discharge Plan for
the child.
Living Arrangement (include location):
Record

Educational/Vocational Plan:
Record

Health Coverage:
Record

Follow-up Health/Mental Health Treatment Plan:
Record

Other:
Record
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SECTION III. REASONABLE EFFORTS TO FINALIZE PERMANENCY
4. If the child is free for adoption, but not yet placed in an adoptive home:
a. Describe the child-specific recruitment efforts that have been made and the outcome of these efforts.
Include whether the foster parent(s) (current and past, as applicable) have been asked to adopt, and the
foster parent(s)’ response.
The response is pre-filled and modifiable based on the following Alternative Permanency Resources question:
Have you explored alternative permanency resources that may be available to the child? If “Yes,” the narrative
for “Have any potential resources been identified? Who are they?” pre-fills. If “No,” the narrative for “Explain why
permanency resources have not been explored” pre-fills.

b. What further recruitment efforts are anticipated in the next six months?
Record

5. If the child is age 14 or older and voluntarily withheld consent to his/her adoption:
a. Describe the facts and circumstances related to the child’s decision.
The response is pre-filled and modifiable based on the following Foster Care Issues question:
Is the legally freed youth 14 years or older refusing consent to his or her adoption? If “Yes,” the narrative for
“Describe the permanency alternatives discussed with the youth including his or her ability to change their mind
about adoption” pre-fills.

b. Describe efforts that have been made to counsel the child about adoption, including explaining possible
post-adoption contact with parent(s) and sibling(s) and enabling/arranging contact with other young
people of similar age who have been adopted.
Record

6. If the child is free and placed in a pre-adoptive home:
a. Describe the reasonable efforts made to facilitate the adoption of the child and any barriers to
finalizing the adoption, including any concerns about completing the adoption raised by the pre-adoptive
parent(s).
The response is pre-filled and modifiable based on the following Foster Care Issues – Barriers to Finalization
question:
Has the child been in an adoptive placement for 6 months or more? If “Yes,” the narrative for “Specify the
barriers preventing legal adoption in this home and actions taken to overcome these barriers and finalize the
adoption” pre-fills.

b. What additional services/assistance is anticipated in the next six months to facilitate finalizing the
adoption?
______________________________________________________________________________________________________
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The response is pre-filled and modifiable based on the following Foster Care Issues – Adoption Readiness
question:
Is the child ready to be adopted? If “No,” the narrative for “What needs to occur to prepare the child for adoption”
pre-fills.

7. If applicable, has the child’s case been transferred to an adoption unit? Select
Yes

No

NA

8. Complete the Adoption milestones grids below, as applicable. Record
Intent to Adopt
Signed

Yes

Adoptive Home
Study Complete

No

Criminal
History Record
Check
Yes

Date Signed

Yes
Date Completed

No

Date Completed

Adoptive
Placement
Agreement
Signed
Yes
No

Date Signed

Date Completed

Interstate
Compact on
Placement of
Children
Yes
No

Date Completed

No

SCR Data Base
Check

Yes

No

Documents that have been secured for finalizing the child’s adoption: check all that apply (*Certified):
Select

Birth Parents
*order(s) terminating
parental rights
*surrender(s)
*consent(s)
*death certificate(s)

mother

father

mother
mother
mother

father
father
father

Child
*birth certificate, two copies
medical report
consent (child over age 14)

Select

Adoptive Parent(s)
financial disclosure affidavit
medical report
*marriage certificate
*divorce certificate
*death certificate (of adoptive spouse)
back-up resource

Attorney
affidavit of readiness
financial disclosure affidavit
*certification of service upon OCA

9. Putative Father Registry request, if applicable.
Was a Putative Father Registry request made?
Yes

Select

No
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Date of request:

Case #
Found

Not Found

Select/record, if applicable

10. Will an adoption subsidy application be submitted for the child? Select
Yes

No

If No, explain why not.
Record

If Yes, check the status of the Adoption Subsidy Application: Select/record
All necessary information submitted by adoptive
parent(s)
--------------------------------------------------------------------Voluntary agency submitted to ACS/Social
Services Department
--------------------------------------------------------------------Pending review at ACS/Social Services
Department
--------------------------------------------------------------------ACS/ Social Services Department submitted to
OCFS NYSAS
--------------------------------------------------------------------Pending review by OCFS NYSAS
--------------------------------------------------------------------Subsidy rejected/returned by OCFS NYSAS
--------------------------------------------------------------------Subsidy resubmitted to OCFS NYSAS
--------------------------------------------------------------------Subsidy approved
--------------------------------------------------------------------Subsidy denied
--------------------------------------------------------------------Subsidy denial appealed
--------------------------------------------------------------------Hearing decision reached

Date submitted:
----------------------------------------------------------------Date submitted:
OR Not Applicable
----------------------------------------------------------------Date review initiated:
----------------------------------------------------------------Date submitted to OCFS NYSAS:
--------------------------------------------------------------------------------------------------------------------------------Date rejected/returned:
----------------------------------------------------------------Date of resubmission to OCFS NYSAS:
----------------------------------------------------------------Date of approval:
----------------------------------------------------------------Date of denial:
----------------------------------------------------------------Date of appeal:
----------------------------------------------------------------Date of decision:
Decision:

If applicable, specify what, if anything, is causing delay of final subsidy approval, and what actions will
be taken to overcome the delay.
Record
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If applicable, why was the subsidy denied?
Record

For approved subsidy, check the applicable category and level of rate: Select
Handicapped
Basic
Special

Exceptional

Hard-To-Place
Basic
Special
11. Have the adoptive parent(s) retained an attorney? Select
Yes

No

12. Has the adoption petition been filed? Select
Yes

No

If Yes,
Date of filing: Record
County: Record
Court: Record

Docketed

Record

Scheduled for hearing on: Record
13. If the permanency goal is Guardianship or Placement with a Fit and Willing Relative:
a. Describe reasonable efforts made and services provided to finalize this plan. Specify the name and
relationship of the guardian or fit and willing relative.
The response is pre-filled and modifiable based on the following Alternative Permanency Resources question:
Have you explored alternative permanency resources that may be available to the child? If “Yes,” the
narrative for “Have any potential resources been identified? Who are they?” pre-fills.

b. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name

Service

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)
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14. If the permanency goal is Another Planned Permanent Living Arrangement:
a. Provide the compelling reason for determining that it would not be in the best interests of the child to
be placed for adoption, placed with a legal guardian, or placed with a fit and willing relative.
The response is pre-filled and modifiable from the following narrative of the Tracked Children Detail window:
“Explain the reason for the PPG change and describe the reason(s) why it is not in the best interest of the
child to do any of the following: return to parent, place for adoption, refer for guardianship, or place with a
relative.”

b. Describe how this arrangement provides the child with a significant connection to an adult who is
willing to be a permanency resource for the child. Specify the arrangement and the name of the adult,
and describe reasonable efforts made and services provided to finalize this plan. If no adult has as yet
been identified, describe efforts made to identify a permanency resource.
The response is pre-filled and modifiable from the following Foster Care Issues question:
• Is the child currently connected to an adult/family mentor in the community that he/she can go to for
emotional support/advice/guidance? If ”Yes,” the narrative for “Identify the resource and relationship to the
child” pre-fills. If “No,” the narrative for “Explain efforts to help the child to connect with such a resource”
pre-fills.

c. What services are anticipated in the next six months?
A pre-filled and modifiable list displays with the following information:
Name
(i.e., Child, Unrelated household member,
Other or None)

15. Is the child AWOL? Select

Yes

Service
(e.g., Drug Counseling/Treatment)

Status of service
(e.g., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

No

If yes, describe efforts to locate the child.
Record
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SECTION IV. CHILD’S FREEING FOR ADOPTION AND PLACEMENT(S)

16.

With the exception of the child’s name, the chart is not pre-filled; you must record all information.

Child’s
Name

Pre-filled,
not
modifiable

Means of
Freeing
(mark all
that
apply)
TPR

Surrender

Death of
Parent

Parent

Date

Mother

Mother

Father

Father

Mother

Mother

Father

Father

Mother

Mother

Father

Father

Number of Changes in Placement Since Freeing or
Previous Permanency Hearing
Record

Appeal Pending

Date Child
was
Completely
Freed for
Adoption

Child Currently Placed - Select
Foster Boarding Home
Non-relative
Relative
Congregate Care Facility
Relative (Direct Placement)
Other

17. Provide current information regarding the placement of the child including: the name of the person(s)
with whom the child is placed, if applicable; changes in the placement setting; protecting factors in the
current home/facility that support the child’s safety, and how this setting supports the least restrictive,
most appropriate placement that addresses the needs of the child.
For children with a Program Choice of “Placement,” the response is pre-filled and modifiable from the following
areas:
• Tracked Children Detail window – “Agency Name: <Name of Agency>” or “Name of Discharge Resource:
<Resource Name>”
• Foster Care Issues – Adjustment and Functioning narrative: “For each child in foster care, describe the
child’s response to separation and loss and the child’s functioning and overall well-being in their current
placement. Also explain how this placement is the most appropriate setting to meet the child’s current
service and health needs and whether it is the least restrictive and most home like setting required to
support eh child’s well-being; if appropriate, include a description of the child’s response to any moves from
one foster care setting to another.”
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18. Is the child placed out of state? Yes

Case #
No

Pre-filled and modifiable

If Yes, explain why it is appropriate, necessary and in the best interests of the child?
For children with a Program Choice of “Placement,” the response is modifiable and pre-filled from the following
Foster Care Issues Adjustment and Functioning narrative:
“For each child in foster care, describe the child’s response to separation and loss and the child’s functioning
and overall well-being in their current placement. Also explain how this placement is the most appropriate
setting to meet the child’s current service and health needs and whether it is the least restrictive and most
home like setting required to support eh child’s well-being; if appropriate, include a description of the child’s
response to any moves from one foster care setting to another.”
For children with a Program Choice of “Non-LDSS Custody,” the response does not pre-fill; you must record a
response.
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SECTION V. VISITING
19. Describe the current visiting plan, including whom the child is visiting (including parents (if there is an
approved contact agreement), siblings, grandparents, permanency resources, etc.), and the frequency,
duration and quality of visits.
This modifiable section pre-fills with active visitation plans recorded in Foster Care Issues where the child(ren) is in
the Child Participant List. The following visiting plan information displays:
• Review Status
• Plan Description
• Primary Location
• Frequency
• Duration
• Visiting Plan Status
• Children
• Adults
• Other Participants
• Response to “Are there any special conditions (i.e., court orders, supervised visitation, phone contacts,
mail) regarding visitation?”
• Response to “Explain the condition. For supervised visitation, explain the reason and how supervision
will be provided”
• Response to “Is assistance necessary to facilitate visitation?”
• Response to “Describe specifically what will occur during visits to enhance parental capability, support
the parent/child relationship and support the child’s well-being”
• Response to “Provide any additional detail regarding location, frequency, or duration of the visiting plan”
If no plan exists for a child, the “No Visiting Plan” narrative will pre-fill for that child.
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SECTION VI. SERVICES PROVIDED TO CHILD
20. Describe all services offered and/or provided to the child since child was freed for adoption or the last
permanency hearing and the outcomes or progress the child has made.
A pre-filled and modifiable list displays with the following Service Plan information:
Child’s Name

Service

Status of service
(i.e., Provide Direct,
Provided Purchase,
Referred/Waitlisted or
Planned)

Describe any additional services for the child anticipated in the next six months.
Record

21. If the child is age 14 or older, describe the Independent Living Skills Services provided to the child since
child was freed for adoption or the last permanency hearing and the skills attained.
Record

Describe any additional Independent Living Skills Services anticipated for the child in the next six
months.
Record

______________________________________________________________________________________________________
Date Printed 03/06/2007

Page X of X

PH-3 Freed for Adoption

PERMANENCY HEARING REPORT
Docket #

Case #

SECTION VII. OTHER SERVICES
22. Describe any other services and assistance that have been provided to the prospective adoptive parent(s)
to expedite the adoption of the child.
Record

Describe the plan for post-adoption services.
Record
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SECTION VIII. CHILD’S HEALTH AND WELL- BEING
23. If applicable, note the following for the child:
Significant Chronic Conditions:
The response is modifiable and pre-filled with:
• all non-end-dated and valid diagnoses for the child recorded on the Health Services Clinical
Appointment tab where the domain is Dental, Physical/Medical, or Substance Abuse, except “HIV
Infection” or “Dementia Due to HIV Infection”; and
• all non-end-dated and valid allergies recorded on the Health Services Child Health Info. tab where
the domain is Dental, Physical/Medical, or Substance Abuse.

Significant Developmental Delay:
The response is modifiable and pre-filled with all non-end-dated and valid diagnoses for the child recorded on
the Health Services Clinical Appointment tab where the domain is Developmental, except “HIV Infection” or
“Dementia Due to HIV Infection.”

Mental Health Diagnoses:
The response is modifiable and pre-filled with all non-end-dated and valid diagnoses for the child recorded on
the Health Services Clinical Appointment tab where the domain is Mental Health, except “HIV Infection” or
“Dementia Due to HIV Infection.”

Serious Injuries/Hospitalization:
The response is modifiable and pre-filled with all valid hospitalizations for the child recorded on the Health
Services Child Health Info. tab, including Hospital Name, Start Date and End Date; the reason for
hospitalization does not pre-fill.

Current Medication:
The response is modifiable and pre-filled with all non-end-dated and valid medications for the child recorded on
the Health Services Child Health Info. tab.

24. Describe any other significant information about the child’s current health and well-being not included
above.
Record

Date of Last
Physical

Date of Last
Date of Last
Dental
Mental
Appointment
Health
Appointment,
if applicable

Date of Last
Vision
Screening

Date of Last
Hearing
Screening

The response is
modifiable and

The response
is modifiable

Record

Record

The response
is modifiable

Immunizations
Up-To-Date

Yes

No

Select
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pre-filled with the
most current,
valid
appointment date
recorded on the
Health Services
Clinical
Appointment
tab where the
Appointment
Type is “Well
Child” and the
Domain is
Physical/Medical.

Case #
and pre-filled
with the most
current, valid
appointment
date recorded
on the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is
“Mental
Health.”

and pre-filled
with the most
current, valid
appointment
date recorded
on the Health
Services
Clinical
Appointment
tab where the
Appointment
Type is
“Dental.”

25. Describe any follow-up treatment or recommendations for the child, as a result of the above
appointments/screenings.
The response is modifiable and pre-filled with a list of all non-end-dated and valid diagnoses for the child
recorded on the Health Services Clinical Appointment tab, except “HIV Infection” or “Dementia Due to
HIV Infection,” including associated treatment recommendations.
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SECTION IX. CHILD’S EDUCATION
26. Provide information on the child’s current grade level or program, academic progress and achievements,
and any other relevant educational information.
The response is modifiable and pre-filled with the following information:
• “Academic Grade Level: <Grade Level>” for the current academic year and the most current Effective Date,
as recorded on the Education window; and
• from the Strengths, Needs and Risks Child Scales, “Academic Performance: <Response>.”

27. Describe the steps the agency will take during the next six months to enable prompt delivery of
appropriate educational and/or vocational services to the child in his or her current placement, or in any
proposed placement (if applicable), or while on trial or at final discharge.
Record

28. Complete the sections appropriate to the age-level and educational status of the child.
a. If the child is under age 3, check which, if any, of the following criteria the child meets:

involved in an indicated case of child abuse or maltreatment Modifiable and
pre-filled if child had any role in any Indicated investigation(s).
suspected to have a disability Modifiable and pre-filled when “Disability” is
selected as the Classification/Disability Type on the Early Intervention tab.
has been found eligible for Early Intervention Services (EI) Modifiable and prefilled when “Disability” or “Developmental Delay” is selected as the
Classification/Disability Type on the Early Intervention tab.
If one or more criteria are met, check the appropriate boxes.
Referral Date

Receiving EI
Services

Not Eligible

This response is
modifiable and prefilled from the
Early Intervention
tab.

Modifiable
and pre-filled if
any service type
is being received.

if no “x”
above in 28a,
check this box

Describe the steps taken to refer the child to Early Intervention Services, the status of the
referral and any services the child is receiving. If the child listed above has not yet been referred,
explain why.
The response is modifiable and pre-filled with:
• a list of all non-end-dated and valid services on the Early Intervention tab that have a status of
“Received”;
• “Date of Referral <MM/DD/YYYY>”;
• “Date of Evaluation <MM/DD/YYYY>”; and
• Classification/Disability Type: “Disability,” “Developmental Delay” or “None.”
______________________________________________________________________________________________________
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b. If the child is eligible for Pre-Kindergarten (turns age 4 before December 1st), check the
appropriate boxes. Select
Pre-K Not
Available

Pre-K
Available

Not Enrolled

Enrolled

If Pre-kindergarten is available and the child is NOT enrolled, describe steps taken to enroll the
child.
Record

c. If the child is age three or older and is suspected of having a disability or has been found eligible
for Special Education prior to or during foster care, describe the status of the referral, the
Individualized Education Program (IEP) related recommendations and services provided by the
school.
If an IEP exists for the current academic year, the response is modifiable and pre-filled with the following
information:
• “IEP Date - <MM/DD/YYYY>”, as recorded on the Education Detail window;
• a list of services, as recorded on the IEP Detail window; and
• a list of related services, as recorded on the IEP Detail window.

d. If the child is school age (ages 6-16/17, depending on locality) or elects to participate in a program
leading to a high school diploma, describe the steps taken to enroll the child in a program or
continue in a program leading to a high school diploma.
Record

e. If the child is over age 16/17 (depending on locality), and the child has elected not to participate
in a high school diploma program, describe the steps taken to assist the child to become employed
and/or to become enrolled in an appropriate vocational program.
Record
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STATE OF NEW YORK, COUNTY OF

Pre-filled and not modifiable

Record, BEING DULY SWORN, DEPOSES AND SAYS:

that I am employed at Record, as a caseworker;
that I have (written

read

) the foregoing permanency report and know the contents thereof;

that the information is true and complete to my own knowledge, or believed to be true based on information derived
from official records and/or reports kept in the regular course of business by this social services district or voluntary
authorized agency directly involved in assessment and/or service provision to the individuals that are the subject(s)
of this report;
that this report is a true and complete copy of the report that was mailed to the parties 14 days prior to the date
certain of the permanency hearing.

Name: _____________________
Title:

_____________________

Sworn to before me this
________ day of ______________

________________________
Notary Public
________________________
Commissioner of Deeds

______________________________________________________________________________________________________
Date Printed 03/06/2007
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